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In the last five years, the growth of the Indian telecommunications sector has outpaced the overall economic 
growth. This sector is poised for strong growth of about 15% in short term during 2013–17, driven by growth 
in organised retail, technological advancements, changing consumer preferences and government support. With 
over 1 billion subscribers, India is the second largest telecom market in the world.

The sector currently employs over 2.08 million employees and is slated to employ more than 4.16 million employees 
by 2022. This implies additional creation of 2.1 million jobs in the nine-year period. 

This Participant Handbook is designed to impart theoretical and practical skill training to students for becoming 
a Customer Care Executive (Relationship Centre). Customer Care Executive (Relationship Centre) in the Telecom 
industry is also known as Customer Service Representative/ Customer Care Associate / Showroom Executive / 
Customer Relationship Officer / Customer Service Executive / Store Executive / Retail Executive.

Individuals at this job provide customer service by handling, following and resolving walk-in customer’s queries, 
requests and complaints and proactively recommend/sell organisation’s products and services. 

This Trainee Manual is based on Customer Care Executive (Relationship Centre) Qualification Pack (TEL/Q0101) & 
includes the following National Occupational Standards (NOSs):

1. Shop/Showroom/Outlet and self-management

2. Sell, up-sell and cross-sell

3. Service desk and customer management

4. Monitor and analyse self-performance

5. Maintain Records and Data expertise

The Key Learning Outcomes and the skills gained by the participant are defined in their respective units.

Post this training, the participant will be able to handle & resolve queries of walk-in customers, sell, up-sell & cross-
sell organisation’s products & services. 

We hope that this participant handbook will provide a sound learning support to our young friends who want to 
build an attractive career in the telecom industry.  

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Unit 1.1 – Objectives of the Program

Unit 1.2 – Telecom Industry

Unit 1.3 – Role of a Customer Care Executive
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At the end of this module, you will be able to:

1. State the objectives of the program 

2. Describe the Telecom industry in India 

3. Understand the roles and responsibilities of a CCE (RC)

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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 � The Telecom Industry

 � Roles and responsibilities of a Customer Care Executive

 � Telecom Relationship Centre specific key concepts

 � Behavioural, professional, technical, and language skills required for performing the job effectively

 � Techniques of Shop/Showroom/Outlet and Self-Management

 � Methods for Selling, Up-selling and Cross-selling

 � Managing Service Desk and Customer Management

 � Ways to monitor and evaluate self-performance

 � Techniques of Data Expertise

 � Interview Skills

1.1.1 Program Overview

 � Communication skills

 � Language Skills (Listening, Speaking, Reading and Writing Skills)

 � Interpersonal Skills

 � Rapport Building

 � Time Management

 � Customer-centricity

 � Selling Skills

1.1.2 This Program Will Cover

At the end of this unit you will be able to:

1. Discuss the overview of the program

2. List down the necessary skills on which the participants will be trained

3. Explain the ground rules to make the program effective

UNIT 1.1: Objectives of the Program

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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…..

Participant Handbook
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 � Manage the shop/showroom/outlet as well as himself

 � Sell, Up-sell and Cross-sell organisation’s products

 � Manage Service desk as well as customers

 � Monitor and analyse self-performance

1.1.3 Main Activities Performed by a Customer Care Executive   
  (Relationship Centre)

 � Arrive and start on time.

 � Participate in all phases of the workshop.

 � Keep mobile phones on silent mode.

 � Participants must adhere to the timelines. A fifteen minutes break means returning to the room within that time.   

 � Participants must not talk amongst themselves. 

 � Listen actively - respect others while they are talking.

 � Learn and ask questions if you don’t understand. 

1.1.4 Rules for Efficient Learning Environment

1. What are your expectations from the training program?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1.2.1 Overview of the Telecom Industry
India is the world’s second-largest telecommunications market. The telecom infrastructure in India is expected to have 
increased at a compound annual growth rate (CAGR) of 20 percent during the period 2008–2015 to reach 571,000 
towers in 2015.

Key Statistics

According to the data released by Department of Industrial Policy and Promotion , the telecom  industry has attracted 
FDI worth US$ 18.38 billion during the period April 2000 to March 2016.

The telecom market in India is expected to grow by 10.3 percent and reach US$ 103.9 billion by 2020. The smart phone 
users In India are expected to increase to 810 million by 2021. According to a study by GSMA, India will become the 
fourth largest smartphone market by 2020

As per the cellular Operators’ association of India, the total number of GSM subscriber in rural India is 330.34 million. 
The telecom companies are looking at rural India to add users and revenues.

Market Dynamics

India could emerge as a low-cost hub for testing security-sensitive IT products used in telephone and other critical 
infrastructure networks, with the country being recently given the ‘authorizing member nation’ status in the Common 
Criteria Recognition Arrangement (CCRA).

India has over 50 percent mobile only internet users, possibly the world’s highest compared to 20 – 25 percent across 
developed countries, according to Avendus Capital. More so, gaining impetus from the increasing penetration of smart 
phones and a whole host of mobile only content, the Indian mobile advertising market is estimated to reach Rs. 2,800 
crore (US $457.52 million) by 2016 from the current Rs. 180 crore (US$ 29.41 million).

Increasing demand for smart phones and availability of high speed networks, such as 3G and 4G services, has resulted 
in the rapid growth of the Indian market, besides offering immense opportunities to players involved in the business. 
The RNCOS’s research study, ‘Indian Mobile Gaming Market Forecast to 2017’ estimated the market to reach Rs. 18.5 
billion (US $302.28 million) by 2017 and grow at a CAGR of nearly 24 per cent during the period 2013–2017.

Source-http://www.ibef.org/industry/telecommunications.aspx

1. Telecom Regulatory Authority of India (TRAI):- The Telecom Regulatory Authority of India (TRAI) was established 
in February 1997 to regulate telecom services in India. Its scope includes fixing/ rivising of tariffs for telecom 

1.2.2 Regulatory Authorities in the Telecom Industry

At the end of this unit you will be able to:
1. Gain knowledge about the Telecom industry
2. Discuss about regulatory authorities in the Telecom industry

UNIT 1.2: Telecom Industry

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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services. The mission of TRAI’s is to create the environment needed for the growth of telecommunication at a pace 
that will enable India to play a major role in the emerging global information society. One of its main objectives 
is to provide a fair and transparent policy that facilitates fair competition. In January 2000, the Telecom Disputes 
Settlement and Appellate Tribunal (TDSAT) was set up to adjudicate any dispute between a licensor and a licensee, 
between two or more service providers, between a service provider and a group of consumers, and to hear and 
dispose of appeals against any direction, decision or order of TRAI.

2. New Telecom Policy:- It is the most important milestone and instrument of telecom reforms in India. The New 
Telecom Policy, 1999 (NTP-99) become effective from 1st April 1999 and laid down a clear roadmap for future 
reforms, such as opening up of all the segments of the telecom sector for the participation of the private sector.

3. The Department of Telecommunications (DoT):- The DoT promotes standardization, research and development, 
private investment and international co-operation in matters relating to telecommunication services. It acts as a 
license body, formulates and enforces policies, allocates and administers resources such as spectrum and number, 
and coordinates matters in relation to telecommunication services in India. 

4. Telecom Dispute Settlement and Appellate Tribunal (TDSAT):- It is a special body setup exclusively to judge any 
dispute between the DoT and a licensee, or between two or more service providers, or between a service provider 
and a group of consumers etc. An appeal against TDSAT shall be filed before the Supreme Court of India within a 
period of ninety days. 

5. Cellular Operators Association of India (COAI):- The COAI was set up in 1995 as a registered non-governmental 
and non-profit society. COAI is the official voice for the cellular industry in India and it interacts on its behalf 
with the licensor, telecom industry associations, man agreement spectrum agency and policy makers. The core 
members of COAI are private cellular operators such as Reliance Jio Infocomm Limited, Idea Cellular Ltd., Bharti 
Airtel Ltd., Aircel Ltd., Videocon Telecom, Telenor (India) Communications Private Ltd., and Vodafone India Ltd., 
operating across the whole country.

The domestic market is also slotted to witness 12% growth this year. The size of India’s off-shore industry is estimated 
at US$120 million and expected to grow to 180 billion by 2015. The industry currently employs around 1 million people 
and provides indirect employment to around 2.5 million people. It is expected to add another 1,50,000 jobs in the next 
fiscal according to NASSCOM.

Name of the Company
1. Bharti Airtel 6. Tata Teleservices
2. Reliance Communications 7. Aircel
3. Vodafone Essar 8. Uninor
4. Idea Cellular 9. Videocon
5. BSNL 10. MTNL

1.2.3 Major Service Players in Telecom Industry

To know the latest trends in Telecom Industry refer to Annexure -1
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1.2.4 The Biggest Challenge Faced by Telecom Industry
Churning of Customers:

Churning refers to switching of customers from one provider to another and often back again or over to a third one. 
The key to winning and retaining customers is up-to-date knowledge of customer segments.

The most common reasons for churning of customers are:

 � Poor performance

 � Poor customer service

 � Poor rate plans

 � Handset issues

The best ways to retain these high rates of customer churn:

 � Effective customer service.

 � Branding and service differentiators.

 � Proper operational and analytical CRM tools in place would help segment and analyse customer behaviour and 
predict their propensity to churn.

 � Proactively strategize and service customers to retain the high value ones. 

Post-paid churn solutions that work:

 � Optimizing subscriber acquisition cost 

 � Managing retention cost

 � An effective pricing dimension 

 � Managing the right customer profile with the right marketing bundle

 � Learning points from past campaigns

1. Which telecom company has the highest market share?

___________________________________________________________________________________________
___________________________________________________________________________________________
___________________________________________________________________________________________

2. Which among the top 10 telecom companies has the lowest market share?

____________________________________________________________________________________________
____________________________________________________________________________________________
___________________________________________________________________________________________

3. Fill in the blank with the correct answer.

India has achieved the distinction of worlds ___________________ call rates. (lowest/highest)

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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4. Write down the full form of the following abbreviations:

a) TRAI

b) DOT

c) COAI

d) TDSAT

5. Name the five regulatory authorities of Telecom Industry.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

6. What is the biggest challenge faced by telecom companies and what are the recommended solutions?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1.3.1 A Customer Care Executive
A customer care executive belongs to an organisation or service centre and is entrusted with the responsibility of 
managing customers’ needs, their replies and work on their satisfaction. Moreover, he/she is a link between the 
company and the customer.

1.3.2 Role and Importance of a Customer Care Executive
Customer Care Executives work as a bridging force between the customer and the organisation. They try to meet the 
needs of the customer within the ambit of management policies. Customer Care Executives should listen, understand, 
analyse a problem, come up with the best solution, and make the customer feel that he has selected the right product 
or service from the company, and should solve their problems and assist them. For example, in a Relationship Centre, 
the customer care executive will assist the customers by solving their problems on choosing a specific service like 
broadband plan or any tariff plan.

At the end of this unit you will be able to:

1. Gain knowledge about the job of a Customer Care Executive

2. List down the personal attributes of a Customer Care Executive

UNIT 1.3: Role of a Customer Care Executive (RC)

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Fig. 1.3.1 Customer Care Executive
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1.3.4 Specific Responsibilities of a Customer Care Executive in a  
  Relationship Centre
 � Individuals in this job provide customer service by handling, following-up on, and resolving walk-in customers’ 

queries, requests and complaints.

 � Individuals in this job are responsible for managing themselves as well as the store.

 � Individuals proactively recommend/sell organisation’s products and services. 

 � Individuals are responsible for monitoring and analysing self-performance.

1.3.5 Personal Attributes: Customer Care Executive (Relationship Centre)
 � Have good communication skills with clear diction

 � Have the ability to construct simple and rational sentences

 � Have good problem-solving skills

 � Have strong customer service focus

 � Have strong selling & listening skills

 � Have the ability to work under pressure

1.3.3 Approach
Approach of an Effective CCE (RC)

An effective CCE understands that his role is critical to the success of the organisation so it is important that 
his approach is correct. The best approach for a CCE to work with customers is the caring approach as a 
customer who feels cared for is a customer for life.

The CARING Approach

C - Courteous

A - Alive and Energetic

R - Responsive

I - Informed

N -  Never says “NO”

G - Guides Right
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1. Why is the role of a Customer Care Executive crucial for the company?

__________________________________________________________________________________________

__________________________________________________________________________________________

2. List some of the personal attributes required to be a successful Customer Care Executive.

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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2. Key Concepts

Unit 2.1 – Relationship Centre Specific Concepts

Unit 2.2 – Customer Relationship Management (CRM)

Unit 2.3 – IT Applications
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At the end of this module, you will be able to:

1. Understand the concepts specific to Relationship Centre

2. Explain the concept and importance of Customer Relationship Management (CRM)

3. Describe the various IT Applications used by a CCE-Relationship Centre

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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2.1.1 Contact Centre
Relationship Centre

A Relationship Centre is generally a retail outlet/shop/showroom started by a telecom company which displays a range 
of products and offers services beneficial to customers. Customer care executives at these types of centres play a very 
important role in attending to the customers face-to-face. They manage the store as well as sell, up-sell and cross-sell  
company’s products and services. 

Service Centre

Every company has a CRM department and a service centre is a part of that. Its main role is to work with a customer 
for their immediate benefit, through their contact centre, help desk and call management system.

Service Desk

Service desk is a single point of contact between company and its employees, customers and business partners. The 
main purpose of a service desk is to ensure that customers always receive appropriate assistance timely. The service 
desk is one of the main options for customers support. 

2.1.2 Key Stakeholders
The key stakeholders for the given job role are:

 � Customer - The person who buys our products/services.

 � Store Manager - The person who is ultimately responsible for the day-to-day operations of a store.

 � Supervisors/Team Leaders - The persons who leads the team and coordinate the overall work.

 � Customer Care Executive - The one who provides customer service support to the company by interacting with 
customers face-to-face.

At the end of this unit you will be able to:

1. Understand and explain various concepts specific to the job role

2.1.3 Processes
Sales Target: The term is used to describe the expected performance over a given time period for an individual sales 
representative or sales team. The individual must understand sales targets and influence customers to buy products.

UNIT 2.1: Relationship Centre Specific Concepts

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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2.1.4 Technologies
There are two types of technologies a Customer Care Executive has to know about:

1. Mobile Technologies

There are two types of mobile technologies:

a) GSM

b) CDMA

GSM: GSM stands for Global System for Mobile Communications. It is the world’s most prolific mobile standard (a 
standard being a set of rules and suggestions about how a mobile network should work). GSM operates on 900 MHz, 
1800 MHz, and 1900 MHz frequencies.

 � GSM is a chip dependent technology

 � GSM handsets have to be loaded with a SIM card

GSM Structural Design

 � The GSM Network Architecture as defined in the GSM specifications has four main domains:-

Monthly Target: Monthly target is a specified amount of sales that a management sets for achieving or exceeding 
within a specified timeframe. 

Sales Process: A sales process describes an approach to selling a product or service. It includes seller and buyer risk 
management, standardized customer interaction during sales, and scalable revenue generation. A sales process consists 
of the following steps:

 � Approaching the customer

 � Probing to identify needs

 � Presenting and demonstrating products and services

 � Handling objections

 � Making the sale

 � Building future sales

Up-Sell: Up-selling is the action whereby a seller induces the customer to purchase more items, upgrades, or other 
add-ons in an attempt to make a more profitable sale.

Cross-Sell: Cross-selling is the action or practice of selling an additional product or service among or between existing 
customer, established clients, markets, traders, etc.

Sales Reporting: Sales reporting functions to serve the overall management of a company’s sales structure. Sales 
reporting starts with an analysis of the lowest level of data. It means to build the data and give a detailed view of sales 
within a defined period and projecting it into the future.

Sales reporting provides visibility into a company’s sales pipeline, integrating information from sales, customer, and 
financial sources for a complete picture of sales performance.

Customer Service: Customer Service is the provision of service to customers before, during and after a purchase. It is a 
series of activities designed to enhance the level of customer satisfaction – that is, the feeling that a product or service 
has met customer expectation.
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• Mobile Station (MS)

• Base-Station Subsystem (BSS)

• Network and Switching Subsystem (NSS)

• Operation and Support Subsystem (OSS)

CDMA: CDMA stands for Code Division Multiple Access. In the context of cell-phones and mobile networks, people 
tend to use it interchangeably to refer to two different mobile standards: CDMA One or CDMA 2000.

Difference between GSM and CDMA

The main difference between the two technologies is the air interface i.e. the interface between your device and the 
base station. The core network side of both the technologies is same.

2. Data Technologies

a. 1G is the first generation cellular network that existed in 1980s. It transferred data (only voice) in an analog wave. 
However, it had the following limitations:

 � No encryption

 � Poor sound quality

 � Low speed of transfer

b. 2G is the second generation technology which introduced the concept of digital modulation, which meant 
converting voice (only) into digital code (in your phone) and analog signals. Being digital helped overcome some 
of the limitations of 1G as it omitted the radio power from handsets, thereby, making life healthier and enhancing 
privacy too.

c. 3G is the current generation of mobile telecommunication standards. 3G allows simultaneous use of voice and 4G 
data services. It offers data rates of up to 2 Mbps. 3G includes services like Video Calls, Mobile TV, Mobile Internet 
and Downloading. There is a bunch of technologies which falls under 3G like WCDMA, EV-DO, HSPA and others.

d. 4G is the latest generation of mobile data connectivity built on the foundations set by 3G. 4G offers a faster and 
more reliable connection. 4G offers features like downloading movies or music, streaming videos and uploading 
images at a much faster speed than 3G. 4G is a quicker and easier technology compared to earlier ones.

2.1.5 Services
Prepaid Services

 � Prepaid service is the Pay-As-You-Go service wherein users buy a recharge balance from the provider as per their  
requirement.

 � Users can only use these services up to the available balance amount post which they will not be able to make calls.

 � Roaming, STD, and ISD services are pre-activated in prepaid connections.

 � The prepaid plans of different companies vary. You can visit the nearest store for details.

Post-paid Services

 � In post-paid services users first avail service benefit and then pay for services.

 � Based on bill cycle dates, a bill is generated at the end of each month and users get a grace period for payment of 
these bills. Once the grace period elapses, outgoing services are automatically barred.

 � Post-paid services also offer benefits of value added services like International Direct Dialling, Voice Mail, Message-
Mate Packs.
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 � The prepaid plans of different companies vary. You can visit the nearest store for details.

Value Added Services(VAS)

 � Value added services mean services which give more value than the standard calling and receiving service. In 
the recent years, however, they have become core services. VAS, therefore, has begun to exclude those services. 
Services which are beyond standard voice call services are known as Value Added Services (VAS). They enable the 
users to use his/ her phone more and through this the operator gain more revenue/ users. Initially SMS/ MMS 
were VAS. 

 � Mobile Value Added Service can be categorised as –

a) SMS Service

b) Information Service

     News alerts, stock prices, air/rail ticket status, bank account balance/transaction alerts etc.

c) Entertainment Service

    Songs, ringtones, caller ring-back tones (CRBTs), wallpapers, games, jokes etc.

d) M-Commerce Service

    M-Payment, M-Banking etc.

MMS

MMS stands for Multi-Media Messaging Services. Multi-Media Messages allow the users to exchange pictures on  
GPRS enabled handsets

GPRS

GPRS stands for General Packet Radio Services. GPRS allows customers to use internet services both on the mobile as 
well as on PC. It allows multiple users to share same air interface resources simultaneously.

Pocket Internet

Benefits of pocket internet are:

Portability

High Speed Mobile Broadband Service

Divide yourselves in groups of two and do a self-study of the relationship centre concepts and then quiz each other to 
check your understanding and learning.

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Practical

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1. What do you mean by key stakeholders? Who are the key stakeholders for your job?

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

2. Write the steps of a typical sales process.

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

3. What is the difference between up-selling and cross-selling? 

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

4. What is the difference between post-paid and prepaid services?

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes
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2.2.1 CRM
An acronym for Customer Relationship Management, the term refers to a systematic approach of handling customer 
relationships.

Benefits of CRM

CRM benefits are usually misunderstood as a tool or an application but in the actual, it is a way of doing business. There 
can be infinite reasons to implement CRM in businesses. Now, let’s take a look at some of the most evident benefits of 
using CRM in the business:

 � 360O view of business

 � Data sharing at Organisation level

 � Effective customer interaction 

 � Good customer support

 � Gain in customer satisfaction

 � Gain in customer retention

 � Help in new business

 � Gain revenue at low cost

Ways to use CRM effectively:

 � Update information accurately

 � Update complete information

 � Update all customer requirements

 � Ensure that you save and submit information

 � Check for old information and update the same when required

 � Check for missing information and update if you see anything blank

At the end of this unit you will be able to:

1. Define the concept of CRM

UNIT 2.2: Customer Relationship Management (CRM)

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Identification & Verification Process

It is the process of checking if you are speaking to the right person. Let us look at some common questions asked for 
verification in the telecom industry:

 � Complete Name

 � Date of Birth

 � Last Paid Bill Amount

 � Billing Address

After you complete the call, the reason customer made the call needs to be categorised, this will allow a telecom 
company to understand customer needs and concerns.

With the evolution of CRM system and process there is a call tag type for almost every question your customer has. 
All you need to do is understand the customer’s query and match it to the broad category e.g. Tariff Plan, Value added 
service, complaints, billing information, active VAS, general, blank call etc.

1. What is CRM?

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

2. What are common security questions?

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

3. Why is it important to verify a caller? 

____________________________________________________________________________________________
____________________________________________________________________________________________
____________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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2.3.1 Basic Functionalities
Telecom call centre executives will need to work on multiple applications like:

 � Intranet site

 � Call taking application

 � Customer Information System

 � Account Information

 � Call Log and Billing System

What is Intranet?

Intranet is a private network that is contained within an organisation. “Intra” means “within.” The “internet” is a web 
between many networks. An “intranet” is a web within a network. Intranet connects people within a network. The 
main purpose of intranet is to share company information among employees. It is also used to facilitate group working 
and teleconferences.

Call Taking Application

Telephone sets with today’s technology can be operated through your computer; you will need to use an application to 
hold, transfer and for conferencing of calls.

Customer Information System

Since telecom industries have a lot of varied information about customers, they usually use different applications to 
maintain information in an organised manner. You will need to use the customer information system to access personal 
information about the customer.

Account Information

Like customer information, account related information is also maintained differently; however it is linked to the 
customer information. If you need to check information on tariff and other VAS you will need to look into the account 
information screens.

Call Log and Billing Information

Financial and closely related information is stored in a different set as this is critical and any mistakes can lead to a direct 
financial loss.

At the end of this unit you will be able to:

1. Understand different IT applications

UNIT 2.3: IT Applications

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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2.3.2 Relevant Applications and Swapping
It is important to swap between applications quickly while on calls as this can play a major role in reducing your �verage 
�andling �ime (AHT). Here are some tips on how you can efficiently swap between screens:

 � Use the keyboard

 � Know where to find the requested information

 � Ensure you login to all the required applications

 � Ensure that you have tagged the call once you finish

 � Make sure that your computer is unlocked while at desk

2.3.3 Fetching Information - Products, Processes and Services
There are different ways to gather information:

Company Intranet

Company’s intranet is the first place where any new products or services will be updated with its launch date.

This is the best place to get information.

Speak to people

Speak to peers and leaders; you always learn something new from people every day.

Call other departments

When you have some free time call other departments to check what actions they take on complex queries, this will 
help you enhance your knowledge and also increase your �irst �all �esolution (FCR).

Keep an eye on the notice board

Keep an eye on the notice board in the office. The company places notice boards on frequently used passages, have a 
glance when you pass by. This is also a quick source to keep yourself updated.

1. What are the different applications on which a Customer Care Executive needs to work?

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

Exercise
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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2. What is the importance of switching between different applications? 

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

3. Mention the areas from where you can source information about new product and services.

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________
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Unit 3.1 – Introduction to Computers

Unit 3.2 – Basics of MS Word

Unit 3.3 – Basics of MS Excel

Unit 3.4 – Internet and Network

Unit 3.5 – Language Skills

3. IT and Soft Skills

TEL/N0105, TEL/N0106,
TEL/N0107, TEL/N0108,

TEL/N0109
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At the end of this module, you will be able to:

1. Know what is a computer and its different parts

2. Understand about MS Word 

3. Understand about MS Excel 

4. Understand about Internet and network 

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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3.1.1 Computer

3.1.2 Computer Hardware

A computer is an electronic device which was invented by 
Charles Babbage. Its main function is to receives data as input, 
processes it, and generates result as an output. It can also 
carry out a set of arithmetic or logical operations automatically 
and can solve more than one kind of problem. A Computer 
generally uses English language for INPUT and OUTPUT.

Computer hardware comprises of the following:

1. Input devices- It helps in inputting data into a computer so that it can be processed into an information. Examples 
of such devices are keyboard and mouse

2. Processing Devices

Processing device are the one which process the data into 
information. Examples of such devices are CPU, motherboard. 

3. Output Devices 

Output device outputs the processed information. Example of such devices are monitor, printer.

UNIT 3.1: Introduction to Computer

At the end of this unit, you will be able to: 

1. Know what is a computer and its different parts

Unit Objectives

Fig. 3.1.1 Computer

Fig. 3.1.2 Keyboard
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4. Storage Devices 

It provides the computer the means of storing the information it has processed. 
Examples of such devices are hard drive, internal memory, USB drive.

3.1.3 Software
Software is a collection of instructions that can be ‘run’ on a 
computer. These instructions tell the computer what to do. 
Software is instructions that tell computer hardware what to do. 
Software are divided into two parts:

1. System Software

2. Application Software 

System Software: An operating system or OS is a System Software 
that enables the computer hardware to communicate and operate 
with the application software or the user. Without a computer 
System Software, a computer and application programs would be 

Fig. 3.1.3 Monitor Fig. 3.1.4 Printer

Fig. 3.1.5 Hard disk Fig. 3.1.6 RAM Fig. 3.1.7 USB drive

useless. This is an interface between Hardware and user/application software. Windows XP, Windows 7, Windows 
8, Mac OS, Linux, Unix etc. are the OSs and used as a system software. Other types of System Software are 'System 
Utilities' and 'Language Translators'.

Application Software: Application software is a program or group of programs designed for end users. Application 
software resides above system software and includes database programs, word processors, spreadsheets, etc. 
Application software may be grouped along with system software or published alone. In the subsequent chapters of 
this unit, you will learn in detail about Application Software like MS Word, MS Excel and MS PowerPoint that are the 
part of the MS office Package. Although the basic knowledge about the MS Office package is given here.

MS Office: Microsoft Office provides a software for efficiently managing your business information, personal 
information and communication tasks. This unit introduces the individual Office applications and teaches you skills to 
start using them. Microsoft Office provides the following toolkits:

Fig. 3.1.8 Application software in window
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 ● Microsoft Office Word

 ● Microsoft Office Excel

 ● Microsoft Office PowerPoint

 ● Microsoft Office Outlook

 ● Microsoft Office Publisher 

 ● Microsoft Office Access

 ● Microsoft Office OneNote

 ● Microsoft Office InfoPath

In this unit, we shall learn about MS word, MS Excel and MS PowerPoint.

MS Word: It is used for word processing - typing, editing, and formatting letters, reports, fax cover sheets, etc. Word 
enables you to need to create a memo at the office or a letter at home, using a computer Its features can help you 
create sophisticated and professional text more quickly with many features such as footnotes, fonts etc. We will learn 
about these various features of word in this unit:

 ● Templates - A template is a starter document that supplies the document design, text formatting, and often, 
placeholder text or suggested text. Add your own text and your document is finished.

 ● Styles - This refers to formatting settings that you can applied to some text, you can save the combination as a style 
that you can easily apply to other text.

 ● Tables - Word allow you to add a table grid to organise text in a grid of rows and columns to which you can apply 
tabel formatting.

 ● Graphics - You can add all types of pictures into your documents and even create charts and diagrams.

MS Excel: Spreadsheet provides formulas and functions that make it easy to present and calculate numerical data. 
Business people don't need to depend on calculators or accountants to perform complicated sales or financial 
calculations. Even a beginner  can  enter some numbers into the spreadsheet and use a few formulas to calculate data. 

Fig. 3.1.9 MS Word

Quick access toolbar Ribbon

Status bar

Title bar Ruler Help

Dialog box launcher

Performance area View buttons
Zoom control
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Microsoft Office PowerPoint: The Microsoft Office PowerPoint presentation has features for communicate information 
and ideas through via an onscreen slide show which can be printed. Every slide can present a different picture. Thus, 
PowerPoint helps to divide information into chunks that audience can absorb more easily. Let us see some main 
themes of the Powerpoint.

Fig. 3.1.10 MS excel

Microsoft Office Excel enables you to do a calculation 
by creating a formula that specifies what values to 
calculate and what mathematical operators to use to 
perform the calculation. Excel also has predesigned 
formulas to perform more complex calculations, such 
as accrued interest, etc.Excel provides tools to assist in 
building and error-checking spreadsheet formulas and 
also gives many choices for formatting the data to make 
it more readable and professional. Let us see some 
excel features:

 ● Worksheets - Excel has file and inside each file, 
one can divide and organise a large amount of data 
across multiple worksheets or pages of information in the file.

 ● Ranges - Excels allow one to assign a name to a section of data on a worksheet so that you can later select that 
area by name, or use the name in a formula to save time.

 ● Number and Date Value Formatting - Excels features allow for applying a number format. A number should be 
displayed indicating details such as how many decimal points should appear and whether a percentage or dollar 
sign should be included. You also can apply a date format to determine how a date appears.

 ● Charts - Excel can help in translate your data into a meaningful image by creating a chart. There are dozens of chart 
types, layouts, and formats in excel to help you present your results in the clearest way.

Fig. 3.1.11 MS powerpoint

 ● Layouts - Themes and Masters. These 
PowerPoint features control the presentation 
of content that appears on a slide and its 
presentation. One can design with ease a single 
slide or the complete presentation.

 ● Tables and Charts - PowerPoint enables you to 
arrange information in formatted grid of rows 
and columns like word and excel. Powerpoint 
can be used with excel to deliver the data you 
have charted in excel.

 ● Animations and Transitions - Powerpoint also 
allow you to set up the text and other items on 
the slide to make a special appearance, such as 
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fly onto the screen, when you play the slide show. You can also apply animation to a transition & see how the 
overall slide appears onscreen, such as dissolving or wiping in.

 ● Live Presentations - PowerPoint offers a number features to customise and control how the presentation looks 
when played as an onscreen slide show. For example hiding slides or jumping between slides onscreen.

Starting an Application (Windows 7 or earlier)

1. Click the Start button at the left end of the taskbar or press the Windows key. This will open the start menu.

2. Click on Programs/All Programs. A list of available programs appears. In XP, it will appears as a submenu of the 
Start menu. In Windows 7, the list appears in the left column of the Start menu.

3. Click on Microsoft Office, the available Office programs appear.

4. Click the desired Office program. The program window appears onscreen.

Closing an Application: When you finish your work in an application, you can shut the application, this will remove it 
from the system memory. Closing the application also provides the possibility of sensitive open files to be viewed by 
others users. You can use any of the below methods to shut down a program:

 ● Press Alt+F4 

 ● Click the program window Close (X) button

If you see a message box with a yes/no to save your work, it means you haven't saved all your changes to the file. Click 
Yes to save the changes to the work you have done. 

1. Identify the input devices:

a. Monitor

b. Printer

c. Keyboard

d. Mouse
2. Identify the output devices:

a. Monitor

b. Printer

c. Keyboard

d. Mouse
3. Which of the following is not a storage device?

a. Pen drive

b. Hard drive

c. Mouse

d. RAM

Exercise
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This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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3.2.1 Microsoft Word

3.2.2 Starting With MS-Word

Microsoft word is basically used for tying 
letters, reports and other documents. In 
this unit we will learning about the basics 
of Microsoft Word.

Opening Word 

There may be a short cut  to open the word file on your system, if it is there double click on that icon in order to open 
the word on your system, if not follow the steps below: 

1. Go the start button 

2. Go to Programs

3. From there go to highlight Microsoft Office

4. Click on Microsoft Word

Creating a New Document

1. Click the File tab and then click on New

2. Click on the Blank Document

3. Then Click on Create     

Opening a Current/ Already Stored Document

1. Click the File tab and then click on Open

2. Click the required document and then click on Open 

UNIT 3.2: Basics of Microsoft Word 

At the end of this unit, you will be able to: 

1. Understand the use of MS-Word

Unit Objectives

Fig. 3.2.1 MS word

About this book
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symbols used in this book are described below.
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3.2.3 The Title Bar

3.2.4 The Ribbon 

The title bar is a bar located at the top of a window that displays the name of the file being used. For example, as can 
be seen in the picture below, the title bar gives the name of the program and document currently being edited.

Quick Access Toolbar: The Quick Access Toolbar has many commands ready for use. It is located at the top left of the 
document above the File and Home tab. 

It has an undo and redo tab to correct errors in your documents. If you click on the Undo command and it will undo 
the last thing you did. 

Windows Control Buttons: These buttons appear on the top right corner of the application. You can use these buttons 
to minimise, maximise, restore, move or close the application.

The ribbon has all the information of Microsoft Office in a visual, streamlined manner through a series of tabs that 
include program features.

Home Tab: Home tab consists of text formatting features like font size, font style, paragraph changes etc. 

Insert Tab: Through this tab on can get an access to insert variety of items such as tables, pictures, header footer, clip 
art etc.

Page Layout Tab: This tab allows you to access various features like adjusting page margins, page orientation, page 
background, inserting columns etc.

Fig. 3.2.2 Title Bar

Fig. 3.2.3 Home tab

Fig. 3.2.4 Insert tab

Fig. 3.2.5 Page layout tab
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Mailing Tab: This tab is used when you need to send a mail. It consists of features such as mail merge, envelopes, 
labels etc.

Review Tab: With the help of this tab you can review your document and rectify spelling and grammar issues. It also 
consists of track changes features which helps to identify the changes made in a document.

3.2.5 Typing Text
You need to keep the cursor from where you want to begin typing. If you want to type from the down instead of top, 
press ENTER till the point the cursor reaches the place from where you want to begin typing.

If you want to begin another paragraph you must press 
enter key. Enter key is also used to give space between 
two paragraphs.

If you want to erase the incorrect words or characters 
appearing on the left of insertion point, press BACKSPACE 
key. If you want to erase the words or characters on the 
right side of the cursor, press DELETE key.

Fig. 3.2.6 Reference tab

Fig. 3.2.7 Mailing tab

Fig. 3.2.8 Review Tab

Fig. 3.2.9 View tab

Fig. 3.2.10 Typing text in a word document

Reference Tab: This tab comprises of table of contents, footnotes, captions, index, table of authorities etc.

 

View Tab: This tab allows you to view your document the way you want. For example if you want to view the document 
by using zoom feature you can view it.
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3.2.6 Formatting Text
Character Formatting 

 ● Font: A group of characters that have a similar 
appearance.

 ● Font Attributes: Additions that enhance your font for 
emphasis. 

 ● Font Size: The size of characters. 

 ● Type Face: A set of characters with a common style and design. 

 ● Bold/Boldface: A formatting option that makes selected words darker than normal. 

 ● Italics: Characters are evenly slanted towards the right. 

 ● Subscript: Text that has been lowered vertically i.e. H2O, 2 is in subscripted form.

 ● Superscript: Text that has been raised vertically i.e. X2 , 2 is in superscript form.

 ● Underline: A horizontal line that is placed beneath characters. 

 ● Bulleted List: A list of key points, each preceded by a symbol for emphasis. 

 ● Modify Fonts: The font section allows you to change text font size, colour, style and several other elements. 

3.2.7 Formatting Documents 
Adjusting Line Spacing 

The default spacing is 1.15 line spacing and 10 points after each 
paragraph. The default spacing in earlier MS Word documents is 
1.0 between lines and no blank line between paragraphs. 

The simplest way to change the line spacing for any document is 
to highlight the paragraphs or the complete document for which 
you want to change the line spacing. 

1. In the paragraph group, go to home tab and click on line spacing. 

2. Do one of the following: 

 ● Select the number of line spaces you want for example, click 1.0 for 
single space and 2.0 for double space.

 ● Select remove space before the paragraph if you want to remove 
additional lines which are added by default after each paragraph.

Fig. 3.2.11 Formatting text

Fig. 3.2.12 Adjusting line space

Fig. 3.2.13 Adjusting line space

Earlier Word versions Newer Word versions
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Paragraph Formatting 

 ● Alignment: It is the way in which lines of text are arranged i.e. full, left, 
right, center.

 ● Full Justified: In this case the lines of text are both right and left aligned.

 ● Left Justification: This is the alignment in which a document is allowed to 
have an even left alignment.

 ● Right Justification: This is the alignment in which a document is allowed to 
have an even right alignment.

 ● Centre Justification: This feature aligns the text horizontally on both the 
sides.

 ● Line Spacing: It is used to provide space between lines in a document i.e. 
single line, double line, triple line, etc. 

 ● Page Break: It shows that the maximum number of lines have been keyed 
on one page and a new page is beginning.

 ●  Tab Key: It allows the user to move the cursor a predetermined number of 
spaces.

Page Orientation 

Bullets or numbers can be added to the existing lines of text or word will 
create lists automatically as you type. 

Inserting Bullets or Numbers:

1. Click on the area where you would like add bullets or numbers.

2. Go to the Paragraph group and click on Bullets or Numbers.

3. Bullets or Numbers will be inserted. 

Select Bullets or Numbering Style: 

1. Select the items for which you want to change bullets or numbering 
styles.

2. On the Home tab click the arrow next to the Bullets or Numbering 
command. 

3. Select the bullet or number format you want to use.

Working with Graphics

Inserting Shapes: There are multiple shapes which can be used in a word 
document. There are lines, arrows, basic geometric shapes, flowchart 

Select either Landscape (horizontal) or Portrait (vertical) 
ororientation for your document. 

Changing Page Orientation

1. Go to page layout, in the Page Setup section and click on 
Orientation.

2. Click on Landscape or Portrait as required.

Bulleted or Numbered List:

Fig. 3.2.14 Paragraph formatting

Fig. 3.2.15 Page orientation

Fig. 3.2.16 Bullet/number list

Fig. 3.2.17 Bullet/number style
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shapes, equation shapes, banners, callouts and stars. After adding one or more 
shapes, you can add text, bullets, numbering, and Quick Styles to them. 

1. In the Illustrations group, go to Insert tab and click on Shapes. 

2. There will be a drop down menu, you need to click on the shape that you 
want to use in the file. 

3. Drag to place the shape wherever you want to use in the document. 

Delete Shapes:  If you want to delete a shape that you don't want, click on that 
shape and press on the delete. 

For inserting Text Boxes: A text box lets you type text anywhere in your 
document.

1. In the Text group, go to the Insert tab and click on Text Box, a drop down 
menu will be visible.

2. Click on a text box and then click Draw Text Box at the bottom of the drop 
down menu that provide the option to draw a text box. 

3. To add text, click in the text box and then paste or type the text in your file.

4. To format text in any text box, select the required text, and using the 
formatting option you can change the text.

5. For changing the position of the text box, click on it and then when a pointer becomes an arrow, drag the text box 
to the required location.

Word Art: Word Art is basically used to add special text effects to your document. For example, you can stretch a title, 
skew text, make text fit a pre-set shape, or apply a gradient fill. If you want to add Word Art to text in your document, 
the following steps must be followed: 

1. Go to the Insert tab, in the Text group, and click on the Word Art.

2. A Drop down menu shall appear and then click on the Word Art Style that you require.

3. A Text Box will appear with the words “Enter your text here” where you can enter the required text. 

Insert Clip Art: 

1. In the Illustrations group, go to the Insert tab and click on Clip Art. 

2. A Clip Art box will appear on the right of your screen, type a word or sentence that describes the clip art that you 
want. 

3. Click on Go. 

4. In the list of the Clip Arts, double click on the Clip Art that you want to insert in the document. 

Insert Picture from File: Insert the picture saved in your hard disk in your computer by using below given steps: 

1. Click where you want to insert the picture or image in the document.

Fig. 3.2.18 Inserting different types of 
shapes

Fig. 3.2.19 Text box

Fig. 3.2.20 Clip Art



38

Participant Handbook

5. On the Insert tab, in the Illustrations group, click Picture. 

6. Locate the picture that you want to insert. For example, you might have a picture file located in My Documents. 

7. Double-click the picture that you want to insert and it will appear in your document. 

3.2.9 Tables
Tables can be used to create lists or format text in an organised manner in any word document.

Inserting a Table in your document

1. Click on the area where you want to insert a table. 

2. In the Tables group, go to the Insert tab and click on Table.

3. You will see a drop down box; click and hold your mouse button and then 
drag it to the selected number of rows and columns that you want inserted. 
You will see a table appear in the document as you drag on the grid. 

4. Once you have highlighted the rows and columns for the table that you  
want, leave your mouse and the table will be inserted in the document. 

Adding a Row or a Column in a Table 

1. Click on the table where you want to add a row or a column.

2. Go to the Layout tab under Table Tools.

3. You need to click on Insert Left or Insert Right to insert a column and click 
on the Insert Above or Insert Below for adding a row. 

4. You need to click on Delete to remove a row, column or cell.  

Deleting a Table 

1. Place the pointer on the table until the table move icon appears and then 

move wherever required by moving the icon.

2. Press Backspace on the keyboard. 

Deleting Content in Tables

If you want to delete only the content of a cell, a row, a column and the complete table, you can delete it by clicking 
on clear content. The rows and columns of the table will remain the same even after you delete the contents of table.

Fig. 3.2.21 Inserting table

Fig. 3.2.22 Table editing
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3.2.10 Headers, Footers and Page Numbers 
Headers, footers and page numbers can be added by using various methods. 
The easiest way is to double click on the top or bottom of the page and the 
header and footer area will appear. You can enter the text you wish to be 
displayed at the top or bottom of every page in the document.

Adding Page Numbers 

If you want a page number on each page in the file by following the below steps: 

1. In the Header & Footer group, go to the Insert tab and click on Page Number. 

2. Click the page number in the location that you require.

3. Scroll through the options which are available and then click the page number 
format that you want to use. 

4. To return to the body of your document, click anywhere on the page.

5. Close Header and Footer section.

Fig. 3.2.23 Header and footer

Fig. 3.2.24 Edit page number

Adding Header or a Footer 

1. In the Header & Footer section, go to the Insert tab and click on Header or Footer. 

2. Click Header or Footer that you want to add and your header or footer area will open in the file. 

3. Type the required text in the header or footer area. 

4. To return to the body of your document, click anywhere on the page. 

Removing the Page Numbers, Headers or Footers 

1. Click on the Header, Footer or Page Number Command in the file.

2. A drop down menu will appear on the screen.

3. At the bottom of the menu, click Remove in the file.

Fig. 3.2.25 Close header and footer Fig. 3.2.26 Header and footer
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3.2.11 Finalising a Document
Using the "Spell Check" Feature 

If any word is spelled incorrectly a red wavy line will appear under that 
word. The fastest way to fix spelling errors is to: 

1. Put your cursor over the misspelled word and right click. 

2. A drop down box will appear with correct spellings of the word. 

1. The Print tab is the place to go to make sure you are printing what you want. 

2. Click the File tab. 

3. Click the Print command to print a document. 

This dropdown shows the currently selected printer. Clicking the dropdown will display other available printers. 

These dropdown menus show currently selected Settings. Rather than just showing you the name of a feature, these 
dropdown menus show you what the status of a feature is and describes it. This can help you figure out if you want to 
change the setting from what you have. 

3. Highlight and left click the word you want to replace the incorrect word with. 

You can also use the spelling and grammar feature in order to complete a more comprehensive spelling and grammar 
check

1. Click on the Review tab 

2. Click on the Spelling & Grammar command (a blue check mark with ABC above it). 

3. A Spelling and Grammar box will appear. 

4. You can correct any Spelling or Grammar issue within the box. 

Print Preview 

Print Preview automatically displays when you click on the Print tab. Whenever you make a change to a print-related 
setting, the preview is automatically updated. 

1. Click the File tab, and then click Print. To go back to your document, click the File tab. 

2. A preview of your document automatically appears. To view each page, click the arrows below the preview. 

Print 

Fig. 3.2.27 Spell check
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Save a Document 

To save a document in the format used by Word, do the following: 

1. Click the File tab. 

2. Click Save As. 

3. In the File name box, enter a name for your document. 

4. Click Save. 

1. Write a leave application, addressing your trainer with the following specifications:

a. Bold and italicise the subject.

b. Bold the date.

c. The letter should be justified

d. Font: Calibri

e. Font size: 12

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Practical

Fig. 3.2.29 Save a document

Fig. 3.2.28 Print preview
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1. Which tab contains the Bold, Italic and Underline options?

a. Home 

b. Insert

c. View

d. Review

2. Ctrl+V command is used to:

a. Copy

b. Paste 

c. Cut

d. Print

3. Save As command is available in:

a. File tab

b. Home tab

c. Insert tab

d. None of these

Exercise

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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3.3.1 Microsoft Excel 

3.3.2 The Ribbon 

MS Excel is a spreadsheet application in the Microsoft 
Office Suite. Excel allows you to store, manipulate 
and analyse data in organised workbooks for home 
and business tasks. MS Excel has many additional 
features and tools that are not available in MS Word. 
These are all described in this lesson.

The ribbon contains all of the commands that is needed to do common tasks. It has multiple tabs, each with several 
groups of commands, and you can add your own tabs that contain your favourite commands. 

UNIT 3.3: Basics of Microsoft Excel 

At the end of this unit, you will be able to: 

1. Understand the use of MS Excel 

Unit Objectives

Fig. 3.3.1 MS Excel

Fig. 3.3.2 Ribbon
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Tabs available in MS Excel

Home Tab: Home tab consists of text formatting features like font size, font style, paragraph changes etc. It also 
comprises of spreadsheet formatting elements such as text wrap, merging cells and cell style.

Insert Tab: Through this tab on can get an access to insert variety of items such as tables, pictures, header footer, clip 
art etc.

Page Layout Tab: This tab allows you to access various features like adjusting page margins, page orientation, page 
background, inserting columns etc.

Formulas Tab: This tab has commands to use when creating Formulas. It consists of an immense function library which 
can assist when creating any formula or function in your spreadsheet.

Data Tab: Data tab helps in modification of worksheets with large amount of data by using features like sorting and 
filtering. It also helps in analysing and grouping data. 

Review Tab: With the help of this tab you can review your document and rectify spelling and grammar issues. It also 
consists of track changes features which helps to identify the changes made in a document.

Fig. 3.3.3 Home tab

Fig. 3.3.4 Insert tab

Fig. 3.3.5 Page layout tab

Fig. 3.3.6 Formulas tab

Fig. 3.3.7 Data tab
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View Tab: This tab allows you to view your document the way you want. For example if you want to view the document 
by using zoom feature you can view it.

3.3.3 Components in the Workbook
Name Box

The Name box provides you with the location or the “name” of a selected 
cell. In the image below, cell B4 is in the Name box. Note cell B4 is where 
column B and row 4 intersect.

Formula Bar

Formula bar is basically used to enter or edit data, a 
formula, or a function that will appear in a specific cell. In 
the image below, cell C1 is selected and 1984 is entered 
into the formula bar. Note how the data appears in both 
the formula bar and in cell C1.

Row

A row is a group of cells that runs from the left of the page 
to the right. In Excel, rows are identified by numbers. Row 
15 is selected in the image below.

 

Column

A column is a group of cells that runs from the top of the 
page to the bottom. In Excel, columns are identified by 
letters. Column L is selected in the image below.

Fig. 3.3.8 Review tab

Fig. 3.3.9 View tab

Fig. 3.3.10 Name box

Fig. 3.3.11 Formula bar

Fig. 3.3.12 Row

Fig. 3.3.13 Column
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Worksheets

Excel files are called workbooks. Each workbook holds one or more 
worksheets or spreadsheets.

Three worksheets appear by default when you open an Excel workbook 
in your computer. You can rename, add or delete worksheets as per 
your need. 

 

3.3.4 Getting Started 
Let us have a look at the steps needed to create an 
Excel document.

Opening Excel

On your desktop you may have a shortcut to Excel, 
if so double click the icon to open Excel. Otherwise 
follow the below given steps: 

1. Click on the Start button of your computer

2. Highlight Programs 

3. Highlight Microsoft Office 

4. Click on Microsoft Excel 

Create a New Workbook 

1. Go to the File tab and then click New. 

2. Under Templates section, double click on the Blank Workbook or Click on Create. 

Find and Apply Template 

Excel allows you to apply built-in templates. To find a template in Excel, follow the below steps: 

1. On the File tab, click on New. 

2. Do either of the following: 

 ● In order to reuse a template that you’ve recently used, click Recent Templates and select the required file. 

 ● If you want to use use your own template, click on My Templates and select the template that you want to 
use and then click on OK. 

3. Click on the template that you like, and it will open on your screen as a new document which you can work on.

3.3.5 Enter Data in a Worksheet 
In this section, we will learn how to select cells, insert content and delete cells.

Fig. 3.3.14 Worksheets

Fig. 3.3.15 Starting with excel
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The cell

The rectangle boxes in a worksheet are called cells. The intersection of 
row or column is called cell. Each cell has a name, or a cell address based 
on which column and row it intersects. The cell address of a selected cell 
appears in the Name box of your document. Here you can see that B3 cell 
is selected.

Cell content

Each cell can contain its own formatting, text, formulas, comments and 
functions.

1. For selection of a cell, click on it.

2. By using keyboard enter content into the selected cell. The 
content appears in the formula bar and cell. 

To delete content within cells:

1. Select the cells that you want to delete.

2. On the ribbon, click the clear command. A dialog box will appear 
on the screen.

3. At last select clear content.

By using keyboard's backspace butto, you can delete content from 
the multiple cells or single cell

To delete cells:

1. Select the cells that you want to delete.

2. On the ribbon, choose the delete command.

 ● Text: Cells can contain numbers, letters and dates.

 ● Formatting attributes: Cells can contain formatting attributes that change the numbers, way letters and dates. For 
example, dates can be formatted as DD/MM/YYYY or MM/DD/YYYY

 ● Comments: Cells can contain comments from multiple reviewers.

 ● Formulas and functions: Cells can contain functions and formulas that calculate cell values. For example, SUM(cell 
1, cell 2...) formula is used to add the values in multiple cells.

To insert content:

Fig. 3.3.16 Cell

Fig. 3.3.17 Inserting content in a cell

Fig. 3.3.18 Deleting content from a cell

Fig. 3.3.19 Deleting the cell
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3.3.6 Cut, Copy and Paste Data 

3.3.7 Column Width and Row Height 

For moving or copying the cell or their content, you need to use the Cut, 
Copy, and Paste commands. 

Moving or Copying Cells 

When you move or copy a cell, Excel moves or copies the entire cell, 
including formulas and their resulting values, cell formats, and comments. 

1. Select the cells that you want to move or copy. 

2. On the Home tab, in the Clipboard group, do the following: 

 ● Click Cut for moving cells

 ● Click Copy for copying cells

3. Click in the centre of the cell where you want to Paste the information.

4. In the Clipboard group, on the Home tab, click on Paste. 

In this section, we will learn how to set column width and row height. 

Set Column’s/Row’s Width/Height 

1. Select the column(s) or row(s) that you want to change. 

2. In the Cells group, on the Home tab, click on Format. 

3. Under Cell Size, choose Column Width or Row Height. 

4. You will see a Column Width or Row Height box. 

5. Type the required value in the Column Width or Row Height.

Automatically Fit Column/Row Contents 

6. Click the Select All button

7. Double click on the corner of the cells between two column/row 
headings. 

8. All Columns/Rows in the entire worksheet will get changed to the new size. 

Set Column/Row Width/Height with Mouse 

1. Place your cursor on the line between two rows or columns. 

2. On the horizontal line a symbol that looks like a lower case ‘t’ with arrows will appear. 

Fig. 3.3.20 Cut, copy and paste data

Fig. 3.3.21 Column width and row height

Fig. 3.3.22 Setting of column width Fig. 3.3.23 Setting of row height
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3.3.8 Merge or Split Cells 

3. Drag the boundary on the right side of the column/row heading until the 
column/row is the width that you require.

To change the width of multiple columns/rows:

1. Select the columns/rows that you want to change. 

2. Drag a boundary to the right of a selected column/row heading. 

3. All selected columns/rows will become of a different size.

To change the width of columns/rows to fit contents in the cells:

1. Select the column(s) or row(s) that you want to change. 

2. Double-click the boundary to the right of a selected column/row heading. 

3. The Column/Row will automatically resize to the length/height of the longest/ 
tallest text.

A cell becomes one large cell if you merge two or more than two adjacent horizontal or vertical cell. When you merge 
cells, the contents one of the cell appears in the merged cell. 

Merge and Centre Cells 

1. Select two or more adjacent cells that you would like  to 
merge. 

2. In the Alignment group, on the Home tab, click Merge and 
Centre. 

3. The cells will get merged in a column or row and the 
contents of the cells  will be centred in the merged cell. 

Merge Cells 

Click the arrow next to Merge and Centre to merge cells and then click on 
Merge Across or Merge Cells. 

Split Cells 

1. Select the merged cell you would like to split.

2. Click Merge and Centre to split the merged cell. The cells will split and the 
contents of the merged cell will appear in the upper left cell of the split 
cells. 

Fig. 3.3.24 Adjusting of column/row 
content

Fig. 3.3.25 Merge and centre cells

Fig. 3.3.26 Merge cells
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3.3.9 Formatting Spreadsheets 
You can format a number of elements such as text, numbers, colouring and table styles in order to enhace your 
spreadsheet. Spreadsheets can become professional documents used for company meetings or even publishing.

Wrap Text 

If you wrap a text in a cell you can display multiple lines of text          
inside it. 

1. Click the cell in which you would like to wrap the text. 

2. In the Alignment section, on the Home tab and click Wrap Text. 

3. The text in your cell will get wrapped. 

Format Numbers 

In Excel, the format of a cell is separate from the data which  is stored in the specific cell. This display difference can 
have a significant effect in numeric data. After typing numbers in a cell, you can change the format in which they are 
displayed to ensure the numbers in your spreadsheet are displayed as you required.

1. Click the cells that has the numbers that you want to be formated.

2. In the Number group, on the Home tab, click the arrow next to the Number Format box and then click the format 
that you require.

Cell Borders 

Border can be added around a cell by using predefined border styles in the options given. You can also create a 
customised borders as per your requirements.

Apply Cell Borders: 

1. On an excel sheet, select the cell or range of cells that you want to add a border, change the border style or remove 
a border. 

Fig. 3.3.27 Wrap text

Fig. 3.3.28 Format cell
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2. In the Font group, go to the Home tab

3. Click the arrow adjuscent to Borders 

4. Click on the border style you would like have

5. The required border will be applied 

Remove Cell Borders:

1. In the Font group, go to the Home tab

2. Click the arrow next to the Borders

3. Click No Border to remove cell border

Cell Fill: 

1. Select the cells that you want to apply or remove a colour.

2. In the Font group, go to the Home tab and select either of the following options: 

 ● Click the arrow next to Fill Colour to fill cells with a solid colour and then under 
Theme Colours or Standard Colours, click on the colour that you need. 

 ● Click the arrow next to Fill Colour to fill cells with a custom colour, click More 
Colours, and then in the Colours dialog box select the colour that you need. 

 ● Click Fill Colour to fill the most recently selected colour.

Remove Cell Fill: 

1. A cell that contains a fill colour or fill pattern, Select it.

2. In the Font group, on the Home tab and click the arrow next to Fill Colour 
and then click on No Fill. 

Text Colour 

1. Select the range of cells or cell, text or characters that you would like to 
format with a different text colour. 

2. In the Font group, on the Home tab and select either of the following 
options: 

 ● Click on Font Colour to apply the most recently selected text colour. 

 ● Click the arrow next to Font Colour to change the text colour and then 
under Theme Colours or Standard Colours, click the colour that you 
want to have.

Bold, Underline and Italics Text 

1. Select the cell, range of cells, or text where you would like to Bold, Underline 
and Italics the Text.

Fig. 3.3.29 Cell borders

Fig. 3.3.30 Cell and text colouring
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2. In the Font group, go to the Home tab. 

3. As needed, Click on the Bold (B) Italics (I) or Underline (U) commands. 

4. The selected command will get applied. 

3.3.10 Formulas in Excel 
Formulas are equations that perform calculations on values in your worksheet. A formula always starts with an equal 
sign (=). 

You can also create a formula by using a function which is a prewritten formula that takes a value, performs an operation 
and returns a value. 

Depending on the type of formula that you create, a formula can contain any or all of the following parts: 

1. Functions: A function, such as SUM(), starts with an equal sign (=).

2. Cell references: You can refer to data in worksheet cells by including cell references in the formula. For example, 
the cell reference A2 returns the value of that cell or uses that value in the calculation. 

3. Constants: You can also enter constants, such as numbers (such as 2) or text values, directly into a formula. 

4. Operators: Operators are the symbols that are used to specify the type of calculation that you want the formula 
to perform.

EXAMPLE of FORMULA WHAT IT DOES 
=5+3 Adds 5 and 3 
=5-3 Subtracts 3 from 5 
=5/3 Divides 5 by 3 
=5*3 Multiplies 5 times 3 
=5^3 Raises 5 to the 3rd power 

Use Auto Sum 

To summarise values, you can also use AutoSum. 
1. Select the cell where you would like your formulas to appear. 
2. In the Editing group, go to the Home tab.
3. Click on AutoSum, to add your numbers or click the arrow next to AutoSum to select a function that you would 

like to apply.

Fig. 3.3.31 Bold, underline and italic text 

Fig. 3.3.32 Auto sum 
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3.3.11 Finalising a Spreadsheet 
Below are a few things, you should use to finalized a document: 

Using the "Spell Check" 

To complete a Spelling and Grammar check, you need to use the 
Spelling and Grammar feature. 

1. Click on the Review tab 

2. Click on the Spelling & Grammar command (This is a blue 
check mark with ABC above it). 

3. A Spelling and Grammar box will appear, you can correct any 
Spelling or Grammar issue with the help of this box. 

Saving a Spreadsheet 

To save a document in the format used by Excel, do the following: 

1. Click on the File tab. 

2. Click on Save As. 

3. In the File name box, enter a name of your document. 

4. Click on Save. 

Fig. 3.3.33 Spell check

Print Preview 

Print Preview automatically displays when you click on the Print tab. Whenever 
you make a change to a print-related setting, the preview is automatically 
updated. 

1. Click the File tab, and then click Print. To go back to your document, click 
the File tab. 

2. A preview of your document automatically appears. To view each page, 
click the arrows below the preview. 

Print a Worksheet 

1. Click the worksheet or select the worksheets that you want to print. 

2. Click File 

3. Click Print. 
Fig. 3.3.34 Printing a worksheet

4. Once you are on the Print screen, you can select printing options: 

 ● To change the printer, click the drop-down box under Printer and select the printer that you want. 

 ● To make page setup changes, including changing page orientation, paper size and page margins, select the 
options that you want under Settings. 

 ● To scale the entire worksheet to fit on a single printed page, under Settings, click the option that you want in 
the scale options drop-down box. 

 ● To print the specific information, select Print Active Sheets or Print Entire Workbook. 

5. Click Print.
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1. Create a data sheet as per the specifications given:
a. Name the sheet Class_Details.xls
b. Create a table with column headers as – Roll No., Name, Date of Birth, Qualification, Age
c. Make a chart which depicts no. of students in various age groups.
d. Highlight the name of students with age less than 25.

2. Recreate the following table in excel and calculate the total amount, deposits and balance.

Practical

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Practical Exercise Summarize

1. Tabs that are available in Excel Ribbon:

a. Data pane

b. Formulas pane

c. Page Layout pane

d. All of these

2. Sort option is used to :

a. Sort the data in increasing order

b. Sort the data in decreasing order

c. Animation

d. Transition

3. Chart option is available in:

a. Data tab

b. Home tab

c. Insert tab

d. None of these

Exercise

2 Opening Balance  $ 500.00  $ 500.00 

3 100 4/7/04 Office Supplies  $   78.50  $ 421.50 

4 101 4/7/04 The Phone Store  $ 180.98  $ 240.52 

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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A B C D E F

1 Cheque No Date Description  Amount  Deposit  Balance 
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3.4.2 The Internet has Changed Our Lives Completely
Internet is an international network of networks that consists of 
millions of private, public, academic, business, and government 
packet switched networks, linked by a broad array of electronic, 
wireless, and optical networking technologies.

The Internet carries an extensive range of information resources 
and services, such as the inter-linked hypertext documents and 
applications of the World Wide Web (WWW), the infrastructure 
to support email, and peer-topeer networks for file sharing and 
telephony. It is a global system of interconnected computer networks 
that use the standard Internet protocol suite (TCP/IP) to link several 
billion devices worldwide.

Applications of Internet

Work: Internet is used extensively at workplace, in media world is as the most important tools as it keeps them up to 
date with the events and current news.

Social aspects: Internet is also used for social media. Social networking sites such as Twitter and Facebook have 
unlimited users all over the world to communicate with their family and friends. These social websites can be accepted 
on cell phones, so the usage is high. 

Education: Schools also use internet for teaching. Many schools use electronic projector systems where teachers show 
online program in the class room by using huge white board. 

Entertainment: It is with the help of internet that we are able to listen to any music with a click of button. To listen to 
music or watch videos Youtube is used.

3.4.1 Network
A group of two or more computers linked together is known as network. There are many types of computer networks, 
such as:

 ● Local Area Networks (LANs): These computers are in the same building.

 ● Wide Area Networks (WANs): The computers are farther apart and are connected by telephone lines or                            
radio waves.

 ● Metropolitan Area Networks (MANs): This means a data network designed for a city or town.

UNIT 3.4: Internet and Network

At the end of this unit, you will be able to: 

1. Understand the internet and network 

2. Understand the use of different applications of internet 

Unit Objectives

Fig. 3.4.1 Internet

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Note: Railway reservation, online banking, payment of bills and mobile recharge, entertainment and education are the 
most common applications of internet.

What is E-mail?

Electronic mail, most commonly referred to as email or e-mail is a method of exchanging digital messages from one to 
one or one to many. Modern email operates across the Internet or other computer networks.

What is a Web Search Engine?

A web search engine is a software system that is designed to search for information on the World Wide Web. The 
search results are generally presented in a line of results often referred to as search engine results pages (SERPs). The 
information may be a mix of web pages, images, and other types of files. Some search engines also mine data available 
in databases or open directories. Top 5 search engines are: Google, Yahoo, Bing, Ask.com and AOL.

1. Browse the internet using google.com and find the names of the CEOs of any 10 pharmaceutical organisations.

___________________________________________________________________________________________

___________________________________________________________________________________________

2. Write the benefits of Internet.

___________________________________________________________________________________________

___________________________________________________________________________________________

Practical

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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2. Full form of www is:

a. Work with work

b. World wide web

c. World wide work

d. World well wisher

3. Which of the following is not a search engine?

a. Google

b. Yahoo

c. Microsoft

d. Bing

1. Different types of network are:

a. LAN

b. WAN

c. MAN

d. All of these

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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3.5.1 Listening Skills
What is listening?

Listening is one of most important skills, but it often gets overlooked. 
Listening is receiving language through the ears. Listening involves 
identifying the sounds of speech and processing them into words 
and sentences. Listening means to correctly receive messages in the 
communication process. A good listener will listen not only to what is 
being said, but also to what is left unsaid or only partially said. Listening 
involves observing body language and noticing inconsistencies 
between verbal and nonverbal messages. In a customer centric job, 
listening plays an important role.

At the end of this unit you will be able to:

1. Understand and practice reading and writing skills for a customer care executive (Relationship Centre)

2. Understand and practice speaking and listening skills for a customer care executive (Relationship Centre)

UNIT 3.5: Language Skills

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Fig. 3.5.1 Listening Skills

We listen:

 ● To get information

 ● To understand

 ● To learn

Importance of listening for your job role:

A customer care executive is the first face to whom customers interact 
with. The motive for a customer to call in call centre is to listen to their 
queries, requests and complaints. So the role of listening is very crucial 
to your job.

As a Customer Care Executive you should:

 ● Interpret customer’s requirement and suggest related product/offer/scheme.

 ● Respond to customer’s Q R C (Query, Request, Complaint) with a relevant answer.

 ● Gauge customer’s communication style and respond appropriately.

 ● Give clear instructions to customers. 
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Guidelines for effective listening 

If you try and follow these guidelines while listening, you will become a better listener.

1. Don’t talk too much

Try to listen more than you talk. Talk to clarify only when the other person has finished speaking.

2. Prime yourself to listen well

Focus fully on the speaker. When in a conversation put other things out of mind.

3. Encourage the speaker

Help the speaker to feel free to speak, in your case it would be the customer. It may also be your colleague or superior. 
Never forget their needs and concerns. Use body language such as other gestures or words to encourage them to 
continue.

4. Remove Distractions

Focus on what is being said: don’t do other activities such as scribbling on paper, shuffling papers, arranging your desk, 
looking out of the window, etc.

5. Empathise with the speaker

Look at issues from their perspective. Put yourself in the other person’s place and understand their point of view.

6. Be Patient

Don’t try to finish other sentences, give them time to complete their thoughts. Don’t interrupt pauses.

7. Avoid Personal Prejudice

Try to be impartial. Do not get irritated or get biased due to the person’s habits or mannerisms.

8. Listen to the Tone of the Speaker

The volume and tone of voice, both are important and tell us more than the words what the speaker is trying to convey.

9. Non-Verbal Communication

Non-Verbal communication or body language such as Gestures, facial expressions, and eye-movements are very 
important. This will be useful while interacting directly with your friends, colleagues and superiors.

Now let’s see a typical conversation between a CCE and a customer which shows active listening. A customer, Leena 
calls at the Customer Care Centre.

CCE: Good Afternoon! I am Kiran, how can I assist you?

Leena: Good afternoon Kiran. My name is Leena Kapoor.

CCE: Sorry?

Leena: My name is Leena Kapoor

CCE: Your name is Leena Kapoor?

Leena: That’s right a…

CCE: Leena as I can see your VC number which is found on our system is 01501571890, is it right?

Leena: That’s right.
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3.5.2 Speaking Skills
What is speaking?

Speaking is an interactive process in constructing meaning that involves producing, receiving, and processing 
information orally. 

Importance of speaking for your job role:

As a Customer Care Executive, it is very important to be effective at speaking. So, how you speak to the customers 
creates an image in the mind of the customer. So you have to speak effectively. Practice is the key for effective speaking. 
All good speakers and successful people practice a lot before speaking. If the listener does not understand what you 
are saying, the speaking skills are of no use.

CCE: Ms. Leena, as I can see, this connection is on your name and your mobile number which we have is 9800012345, 
is it right?

Leena: That’s right.

CCE: And your e-mail id is name@hotmail.com, is it right?

Leena: That’s right.

CCE: Thank you for giving us information. Sorry for the inconvenience. Ms. Leena, how can I assist you?

Leena: Just wanted to check with you about my M Tariff Plan, the date for deactivation is 23 February, when do I have 
to reactivate my plan?

<Pause for 2 seconds>

CCE: Sorry?

Leena: When should I reactivate my tariff plan meaning to say…recharge my SIM?

CCE: Alright, you are asking for tariff recharge plan.

Leena: That’s right!

CCE: Am I right?

Leena: Yeah! Yeah! That’s right!

CCE: Your next recharge date is 25 March 2014.

Leena: OK. Alright! Thank you so… much! Bye.

CCE: Ms. Leena you can check on your package due date either from SMS or my Plan M on net also. I am sorry for the 
inconvenience. Ms. Leena, you want any further information from my side?

Leena: No, thank you very much Kiran, thank you.

CCE: Welcome. Ms. Leena, thank you for calling ABC customer care centre. Have a nice day!

Leena: Thank you, bye!
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As a Customer Care Executive you should:

 � Be prepared

 � Know your content well

 � Use simple language

 � Use examples - the customers will understand when you use examples

 � Be aware of your body language so that it shows in your voice

 � Discuss self-performance basis performance criteria with the supervisor

 � Probe customers appropriately to understand the nature of problem

 � Avoid using jargons, slang, technical terms and acronyms when communicating with customers

 � Clearly communicate with peers/seniors during morning brief

Components of Speaking Skills

The important components of speaking skills are:

 � Tone         

 � Comprehension

 � Grammar

 � Vocabulary

 � Pronunciation 

 � Fluency

 � Body language 

 � Rate of Speech 

Tone

Tone involves the volume you use, the level and type of emotion that you communicate and the emphasis that you 
place on the words that you choose. If you speak with lack of energy and in a monotonous tone, then certainly the 
customer will get bored.

Comprehension

Oral communication requires a subject to respond to speech as well as to initiate it. 

Grammar

It is needed that you arrange a correct sentence in conversation. The utility of grammar is also to learn the correct way 
to gain expertise in a language in oral and written form.
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Vocabulary

One cannot communicative effectively or express their ideas in both oral and written form if one does not have sufficient 
vocabulary. Without vocabulary nothing can be conveyed. So, without mastering vocabulary in English learners will not 
be able to speak English or write properly.

Pronunciation

Pronunciation is the way to produce clear language when you speak. It is too technical for learners to understand 
pattern in a language. Pronunciation is the knowledge of how the words in a particular language are produced clearly 
when people speak. While speaking, pronunciation plays a vital role in order to make the process of communication 
easy to understand.

Fluency

Fluency can be defined as the ability to speak fluently and accurately. Fluency means speaking at a normal speed 
without hesitation, repetition and self-correction. To be fluent its important, that you do not use fillers like “you know”, 
“I mean”,“ums”, “ers”,“aaahhhh”, etc. 

Body Language

Body language means communicating through body posture, gestures, facial expressions and tone of voice. Body 
language must be in sync with your words; otherwise it is likely to confuse customers. Positive body language is 
important in supporting your words and ensuring that your message is understood correctly.

Rate of Speech

A slow rate of speech makes the conversation disinteresting. Speak at a moderate pace and with appropriate volume. 
An executive should match his rate of speech with that of the customer.

What is reading?

Reading refers to the specific abilities that enable a person to read with independence and interact with the message. 

3.5.3 Reading Skills

Fig. 3.5.2 Reading Skills
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Importance of reading skills:

Good reading skills help you to comprehend ideas and understand documents. You can extract from reading a document 
what is important for the particular task you are employed for. 

As a customer care executive, you will need to:

 � Read data related tariffs, offers and schemes. 

 � Read daily, weekly and monthly reports. 

 � Analyse and comprehend daily, weekly and monthly reports, to monitor performance. 

 � Read about new products and services of your organisation through the intranet portal.

 � Keep abreast with the latest knowledge by reading brochures and pamphlets related to your work. 

Techniques for good reading skills:

There are three techniques for effective reading:

 � Scanning

 � Skimming

 � Reading for detail

Scanning:

In a given text, scanning is used to look for a specific piece of information. In scanning, you don't pay attention to 
every detail, you only look for information that you specifically need. You can stop reading once you find the specific 
information.

Skimming:

Skimming is used to identify the main points in a document. When you skim read a passage, you should get all the 
essential information from the passage. 

Reading for Detail:

When you read complete passage from the beginning to the end it is called reading for detail. You should read each 
and every sentence in the given document if you are reading for detail.  
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3.5.4 Writing Skills
What is writing?
Writing is a medium of communication that represents language through the inscription of signs and symbols.

of exciting prospects, but also raises questions about how new technologies and services can best be used to achieve 
society’s goals. In this increasingly digital environment, some key questions need to be addressed to assess the readiness 
of countries’ legal and regulatory frameworks and assist policy-makers and regulators in pushing forward their national 
digital agendas within the context of a globalized, connected world.

Questions:

a) What is ICT industry all about?

__________________________________________________________________________________________

__________________________________________________________________________________________

b) Why is ICT industry still one of the most vibrant and dynamic global market?

__________________________________________________________________________________________

__________________________________________________________________________________________

c) What are the pros and cons of living in a highly networked society?

__________________________________________________________________________________________

__________________________________________________________________________________________

d) Who is responsible for addressing the key questions related to Telecommunication industry?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Practice reading this passage and then answer the questions given below:

Passage 
The ICT (Information and Communication Technology) industry remains one of the most vibrant and dynamic global 
markets; as more and more people are getting connected, new applications and services are being developed and 
users’ online experiences are expanding throughout the world. Living in a networked society certainly brings a host 

Practical
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Importance of writing skills
As a Call Centre Executive you will use your writing skills to write mails, reports and communicate effectively at 
work. As a CCE, it is very crucial to have effective writing skills because often you will communicate with others in 
the organisation through mails or written reports. For a brief writing style, omit needless words, combine sentences 
wherever necessary and reframe the sentences in the best possible way.
For example: Instead of saying, “Our main objective is to increase sales. Specifically, the objective is to double the sales 
in the next five years by becoming a more successful business.” you can say, “Our objective is to double the sales in 
next five years.”
As a customer care executive, you should:

 � Plan, organize, and write.

 � Assemble all useful information.

 � Determine what is important.

 � Choose what to leave out.

 � Group the information logically. 

 � Record complete and correct customer information, complaints, queries & requests in the CRM/ Excel for clear 
information & action.

Fig. 3.5.3 Writing Skills
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1. What are the three objectives of effective listening?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
2. How is body language important for a CCE?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Writing Practice 1

The Birthday Party
Directions: Read the story below. Then finish it by yourself.
Today is my birthday. I am having a big party at my house. I have invited everyone in my class. I hope that they all
come. My doorbell is ringing. I answer it. Three of my friends are at the door! The rest of my friends arrive. It is time for 
the party to begin. First, we play games. We play pin the tail on the donkey. Jasmine wins. My mom gives her a prize. 
She is very happy. I am happy that my friends are having fun. We also play tag and musical chairs. Next, we eat cake. 
My favourite kind of cake is chocolate with vanilla icing. My mom has made a special cake for me. She wrote “Happy 
Birthday” on it in red icing. Mom lights the candles. My friends sing the birthday song. I make a wish and blow out my 
candles. Now it is time to open presents. Ram hands me the first present. I unwrap it and open the box.

_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________

Writing Practice 2
Directions: Try to answer the question below.
Question: Which is your favourite day of the week? Why?
Example Answer: My favourite day of the week is Wednesday. I usually play football at night with my friends on 
Wednesday. I think football is the best sport in the world.

_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________

Practical
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symbols used in this book are described below.
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3. Write any five components of speaking.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

4. Write three techniques of effective reading.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
5. Write 3 ways in which you could skim while reading.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
6. Why is writing skill so important for a CCE?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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4. Shop/Showroom/
    Outlet and Self-
    Management

Unit 4.1 – Morning Briefing

Unit 4.2 – Professional Dressing

Unit 4.3 – Store Management

Unit 4.4 – Time Management

Unit 4.5 – Code of Ethics and Code of Conduct

TEL/N0105
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At the end of this module, you will be able to:

1. Discuss the importance of briefing in the morning

2. Describe the importance of self - grooming

3. List down the importance of store management

4. Explain the importance of code of ethics and code of conduct needed for a CCE (RC)

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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At the end of this unit you will be able to:

1. Discuss the importance of morning briefing

4.1.1 Case Study: The Essential Daily Technology
The Morning Briefing: The essential daily Technology, Media and Telecoms news briefing for senior executives.

Start the day empowered with key industry news, written and delivered by our specialist journalists direct to your inbox 
at 8.30am GMT, each weekday. The Morning Briefing has been established for more than 12 years, gaining an enviable 
reputation for clarity, relevance and expert story selection. The content is broken down by sector, including online 
news, broadcast, print, telecoms news, media policy developments and multimedia news content. It is delivered in an 
informed, concise format, compatible with handheld device for busy executives on the move. During working hours, 
high-level news alerts on major breaking TMT stories are delivered as soon as they occur, to ensure you keep up-to-
date with the news agenda. An additional weekend round-up detailing the key developments from the weekend’s TMT 
news is distributed every Monday by 6.30am - providing insight so that you’re prepared with industry developments. 
The Morning Briefing's ever-expanding client list includes broadcasters, newspaper groups, online media companies, 
telecommunications companies, firms, consultancies, regulators, legal practices and market research firms. Executives, 
directors and senior managers find the Briefing and Weekend Round-up valuable as a solution to information overload.

What does the client list of morning briefing include? 

__________________________________________________________________________________________

__________________________________________________________________________________________

4.1.2 Morning Briefing
As a customer care executive, the first and foremost thing you have to take care is 
of managing yourself. In managing yourself you have to manage the store as well.
So let’s learn in managing the above two aspects, what are the things we have to 
take care of. Morning briefing is first and crucial aspect of starting the day and goal 
in managing yourself and the store.
Briefings are the most common kind of oral presentation. Morning briefing is a lean 
process meeting held at the start of the day. It can be used to distribute news and 
also set the plan of action for the day. The Store Manager leads the meeting with 
the store team. It is very important part of the day for the CCE because it gives the 

UNIT 4.1: Morning Briefing

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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Fig. 4.1.1 Morning Briefing
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1. List few objectives of morning briefing.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

purpose or plan of action for the day and sets the day. It aligns the team together. The store manager ensures that the 
briefing should always be accurate, brief and clear.
Some of the things that are discussed in a Telecom Relationship Centre, during morning briefing are:

 � Obtain new product/services/process changes in the Industry

 � New schemes/offers and targets of the products and services

 � Share knowledge of latest trends in telecom industry

 � Task Distribution from the Store Manager to the CCEs

As a CCE you should: 

 � Attend morning briefing daily before the store opens.

 � Listen carefully to what the speaker is saying.

 � Maintain eye contact with the speaker.

 � Clearly communicate with peers/seniors during morning brief to understand the targets for the day & also review 
the previous day's performence.

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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At the end of this unit you will be able to:

1. List down the dress code of a CCE (RC) - both men and women

4.2.1 Example
Before starting the session let’s talk about a Call Centre in Japan, which focuses on professional dressing so much 
that it is mandatory to wear organisation’s professional uniforms even for the call centre executives who do not talk 
to customers face-to-face but through phone call. According to the Chairman of the Organisation, “The professional 
dressing gives a sense of responsibility and relates them to organisation even when they are on call.”

4.2.2 Call Centre Executive Grooming
When working at a Relationship Centre, CCEs need to present a neat and professional appearance as they are the once 
who meet the customers first and leave an impression in their mind. You should “feel good” about the way you look 
and project a positive image of self and the organisation. Being well-dressed is a compliment to customers  you meet. 

Once you enter your store/department you need to be dressed in full uniform as per company norms, and also properly 
groom yourself as per the service standards.

Appearance

The frontline person/team is the brand ambassador of the store. Customers visiting the stores are greeted by this team 
and are assisted by them. Hence, they are expected to present a neat and clean appearance.

You are the CCE and being a part of this team you should: 

UNIT 4.2: Professional Dressing

Fig. 4.2.1 Professional Dressing

Unit Objectives
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 � Follow organisational guidelines with respect to standard uniform and name badges.

 � Wear name badges as per organisational guidelines.

 � Have neat and clean fingernails, teeth, shoes, hair and face.

 � Demonstrate a positive attitude.

 � Maintain eye contact.

 � Shake hands firmly.

 � Neither interrupt nor argue.

 � Lastly, remember to smile and be friendly.

4.2.3 Specific Uniform Guidelines
Sl. No. Specifically for Men Specifically for Women

1 Uniform prescribed should be clean and ironed. Women with long hair should tie their hair. Not 
much oil should be applied.

2 Shoes should be clean and polished. They should avoid bright coloured nail polish and 
long nails as they may distract customers or damage  
merchandise on display.

3 Hair must be short, clean and tidy. Minimum, non-flashy jewellery should be worn.
4 One is expected to have a clean shaven look. Dangling earrings, noisy anklets & bangles must not 

be worn on the floor.
5 Beard or moustache must be trimmed, neat and 

tidy
Only very light make-up to be applied (lip- stick of 
very light shades only).

6 Nails should be cut or trimmed neatly at regular 
intervals.

Any type of earrings studs & bracelets are not to be 
worn on the floor during official hours.

1. What are the specific uniform guidelines for men and women? 

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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The managing of a store, organising inventory, stationery, pantry stock and display of products and services etc. 
comprises of store management. As a Customer Care Executive, you are also responsible for managing the store. While 
managing the store you have to take care of the store atmosphere and visual merchandising. Let’s talk about it one by 
one.

4.3.1 Store Management

At the end of this unit you will be able to:

1. List down the importance of Store Management

UNIT 4.3: Store Management

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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Fig. 4.3.1 A retail store
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As an Customer Care Executive, you must understand that every customer is precious. Keeping your store neat and 
clean is best way to attract customers and create a pleasant store atmosphere. 

Here are a few things to keep in mind to keep your store neat and clean:

Cleanliness of the Counter

The counter where you display your goods must be clean and tidy. All handsets should be cleaned and wiped with 
an antiseptic solution cloth to prevent infections. All pamphlets, brochures and reading material must be properly 
displayed in the respective boxes.

At all times the store must look organised and clean. 

Restrooms

Restrooms should always be clean and adequate even if they are not open for public use. Stock the bathroom well with 
paper products, soap and dustbins and make sure it is cleaned daily.

Music

Background music in a retail store helps to create a certain atmosphere for shoppers. Music that is too loud or 
inappropriate can ruin a positive shopping experience.

Clean Floor or Ceiling Tiles

Dirty carpets, stained floors and broken ceiling tiles can be a turn off. Cleaning, sweeping, vacuuming and repairs 
should be done on a regular basis.

Lighting

Replace any burned out light bulbs as soon as possible. Make sure all customer areas of the store have ample lighting. 
Your store should be well lit for all customers.

Odours

Bad odors give a bad feeling. Certain odors are understandable however, shoppers don’t want to smell an employee’s 
lunch or the toilet. Use neutralisers to combat any offensive odors. You can also user agarbatties and deodorants to 
make your store better.

Organized Billing Counters

The particular area where a customer’s financial transaction is taking place should not show any signs of disorganisation. 
Keep those register areas neat and tidy.

4.3.2 Store Atmosphere
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Visual Merchandising

The purpose of visual merchandising is to attract customers to the merchandise for closer examination. Success in VM 
involves the use of design. 

• The elements of design include: 1. Colour 2. Texture 3. Line 4. Light 5. Shape 6. Motion.

• The principles of design are: 1. Emphasis 2. Movement 3. Balance 4. Proportion. Emphasis is drawing the attention 
of the viewer to the most important part of a display. Movement refers to the way the design guides the viewers’ 
eyes over an item or display. 

Balance refers to the way items are placed around an imaginary centre line. Proportion refers to the size and space 
relationship of all items in a display. Store design is an extension of integrated retail communication. It is a powerful 
communication weapon. It communicates store image and plays a dual role of attracting customers, and inducing 
customer’s purchase decision.

Planograms

Planograms are visual representations of a store’s products or services. They are considered a tool for visual 
merchandising. According to the Oxford Dictionary, “It is a diagram or model that indicates the placement of retail 
products on shelves in order to maximise sales.” Planograms therefore help dictate a retail store’s layout. The ultimate 
effectiveness of the planogram can be measured by sales volume.

Planograms provide many positive benefits, such as:

 � Allotting selling potential to every inch of space and satisfying customers with a better visual appeal to the customer

 � Ensuring tighter inventory control and reduction of out-of-stocks

 � Easier product replenishment for staff

 � Better related product positioning

 � Effective communication tool for staff-produced displays
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1. What is store management?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
2. List five measures to maintain store atmosphere.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
3. What is the role of visual merchandising?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
4. What points should be kept in mind while managing the store?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Exercise
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At the end of this unit you will be able to:

1. Describe the importance of Time Management

Time management is about effective scheduling of your time, goal setting, prioritizing and choosing what to do and 
what not to do, delegating tasks, analysing and reviewing your spent time, organizing your workspace, keeping your 
concentration and focus at your work, motivating yourself to work towards a goal.

Time management requires:

1. Effective planning

2. Setting goals and objective

3. Setting deadlines

4. Delegation of responsibilities

5. Prioritizing activities as per their importance

6. Spending the right time on the right activity

4.4.1 Time Management

UNIT 4.4: Time Management

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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Fig. 4.4.1 Time management
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Time robbers are those activities which create interruptions at your workplace. These activities create a deviation from 
the objectives which needs to be achieved. 

Time Robbers could be:

 � Poor personal planning and scheduling. For example, lack of planning at the start of the day would result in non-
completion of tasks assigned for the day and finally result in non-achievements of targets.

 � Interruptions by other colleagues. For example, gossiping with peers at the store is one of the time robbers for a 
CCE.

 � Poor delegation of Authority. For example, if the right task is not assigned to the right person then generally a task 
is not completed and this leads to wastage of time. 

4.4.3 Time Robbers

Let’s learn about Urgent and Important Matrix. This matrix will help you plan and organize your targets and schedule 
to help you meet the company’s expectation of you.

This matrix helps you understand:

1. What should be done

2. What should be planned

3. What should be resisted 

4. What should be rejected

4.4.4 Urgent and Important Matrix

Urgent and the important tasks Non-Urgent but important tasks
DO NOW
Handle customer complaints and issues
Order from superiors
Meetings with superiors

PLAN TO DO THEM
Planning and scheduling of next day’s activities
Preparing or updating the daily report

4.4.2 Importance of Time Management for a Customer Care Executive 
at Relationship Centre
As a CCE (RC), you need to attend to walk-in customers and perform other tasks of the store. To carry out these 
function, you need to:

 � Manage time while performing multiple responsibilities of the store

 � Manage one’s own time and the customer’s time by holding precise discussion and interactions

 � Prepare assigned reports within available time limits
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Non-Important but Urgent tasks Non-Important and Non-Urgent tasks
REJECT AND EXPLAIN 
Trivial requests from customers
Apparent emergencies
Misunderstandings at work
Pointless routines or activities

RESIST AND CEASE
Playing computer games
Net surfing
Excessive cigarette breaks
Engaging in chat, gossip, social communication
Reading irrelevant and useless material

1. What are your time robbers?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What will you do as a CCE to manage your time at store?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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_______________________________________________________________________________________________
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4.5.2 Code of Ethics
It’s important to follow the code of ethics outlined by your company. These could be regarding different facets of your 
role, like the way you speak, the way you identify yourself, the way you deal with the data of the customer, etc.

The Code of ethics for an In-Store Promoter is:

Identification
 � Always identify yourself as a representative of your company clearly indicating your role.

Before beginning this session we will look at one case of an employee working in an organisation. It will give you a 
clear idea about the code of Ethics and code of conduct in any organisation. This story is about Ramaswamy, who is 
a very hardworking and sincere employee of an organisation. Once a client comes to visit him as he is responsible 
for attending to clients and finalising projects. After seeing the project he finalises it. The vendor, being very happy 
with Ramaswamy gifts him a pen. Ramaswamy thinks of it as a token of appreciation, accepts it. The vendor leaves. 
Everything goes well till one day when one of Ramaswamy’s peers notices the pen. He points out that the pen was not 
a normal one but a diamond graded Swarovski pen. According to the organisation it was against the code of ethics to 
accept and use such high end gifts from a customer. Ramaswamy did not know. He was asked to leave the organisation. 

1. If you were in Ramaswamy’s place and the pen was gifted to you what would you have done?

__________________________________________________________________________________________

__________________________________________________________________________________________

2. If you were ask to leave the organisation how would you justify your action to your seniors and apologise for the 
violation of Code of Conduct of your organisation?

__________________________________________________________________________________________

__________________________________________________________________________________________

At the end of this unit you will be able to:
1. State the need and importance of code of ethics and code of conduct

4.5.1 Case Study

UNIT 4.5: Code of Ethics and Code of Conduct

Unit Objectives
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 � Make sure you have your identity card with you at all times and show it to the customer voluntarily.
 � You Identity card must have the contact no of your supervisor/ company help line.
 � Never misrepresent yourself as anyone else, like someone who is taking a survey, or anyone else.  

Ethics
 � Be ethical and fair as you deal with customers.
 � Capture any promise you make to the customer as per your authority in the system.
 � Always state the correct and exact amount to be paid by the customer for a purchase.
 � Do not deal with the customers at a personal level. Always act as a representative of your company.
 � Do not pay visits to the customer’s house without company’s acknowledgment.

Fraudulent Practices

Fraudulent practices can lead to immediate termination of employment, prosecution and police complaints of the 
concerned In-Store Promoter. The following practices are defined as fraudulent practices:

 � Tampering, falsification or unauthorised overwriting of cheques, receipt books, drafts, and other negotiable 
instruments.

 � Tampering, falsification and false commitments on receipts and settlement letters.
 � Using the cash payment of customer for personal purpose, even if for a temporary period.
 � False commitments to customers, verbal or written, promising waivers, settlements etc.

Your code of conduct requires you to behave like a professional. This requires you to keep a neat and tidy workstation. 
This reflects your thought process. It has been proven scientifically that a person in a neat area can think clearly. Ensure 
that all the paperwork you do in the whole day is stacked nicely at the end of the day. 

We need to respect our workplace. We show our respect at the workplace by:
 � Respecting the people around us.
 � Respecting resources at work.
 � Not misusing resources like paper, stapler, printer, etc.
 � Respecting resources and not doing anything to damage resources available for our use.
 � Not littering

It is important for you as a Customer Care Executive:
 � To be at work on time.
 � To always take planned leave.
 � Stay in a company till you have learned the ropes well.
 � Not to job hop as it reflects poorly on your commitment to your organisation. 

4.5.3 Code of Conduct
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1. What according to you should be the code of ethics apart from above mentioned measures?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. List two codes of conduct that you follow in your day-to-day life at the store. 

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Exercise
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5. Sell, Up-Sell and 
    Cross-Sell

Unit 5.1 – Communication Skills

Unit 5.2 – Sales Process

Unit 5.3 – Data Confidentiality
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At the end of this module, you will be able to:

1. Describe verbal and non-verbal communication

2. Practice effective communication at work place

3. Discuss different types of selling processes

4. Explain importance of data confidentiality in the industry

Key Learning Outcomes
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This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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At the end of this unit you will be able to:

1. List down different types of customers

2. Describe verbal communication

3. Describe non-verbal communication

5.1.1 Communication Skills
For selling, up-selling and cross-selling telecom products/services, the Customer Care Executive has to be at his best 
communication style. For effective communication, the CCE has to focus on four important things. They are:

1. Understanding the customer’s communication style

2. Clarity in communication

3. The Art of Listening

4. The Art of Asking Questions

5.1.2 Understanding the Customer’s Communication Style
You, as a call centre executive should gauge the customer’s communication style and respond appropriately. You should 
switch to the customer’s preferred language as and when required. You must not let the customers feel uncomfortable 
and annoyed by not facilitating them. Let us see the different kinds of customers and how to respond appropriately to 
them.

Types of Customers

Repeat Customer- The most loyal customer is a repeat customer or one who regularly purchases products from your 
store. This type of customer is the life blood of the business and should be respected, as such. Because they were 
satisfied the first time, they returned for more services or products. Therefore, as long as you continue to satisfy their 
needs, you have a repeat customer. It has been estimated that it can take up to five times more work to replace a loyal 
customer as it would to simply continue to service them well enough to keep them.

Discount Customers- Such customers frequently visits store but buy only when offered discounts on regular products 
and brands or they buy only low cost products. Focusing on such customers is also important as they promote a 
distinguished part of profit into business.

Impulsive Customers- These customers are difficult to convince as they want to buy impulsively. When they enter in 
the store they don’t have any specific item in mind but simply have an urge to buy what they find good and productive 
at that point of time. Channelising these customers can be a challenge as they are not looking for a particularly product 
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Effective listening is an active endeavour. It is much more than just hearing what customers say. Good listeners project 
themselves into the customer’s mind. If a customer says he wants the “best” tariff plan, the salesperson needs to 
listen carefully to find out what best means to that customer. It could be in terms of rates or more minutes to talk or 
more messaging options etc. Through effective listening, the Customer Care Executive demonstrates concern for the 
customer’s needs by selecting appropriate merchandise to present and demonstrate. 

Techniques for active listening include:

Repeating or rephrasing information - One technique of showcasing active listening could be repeating or rephrasing 
what the customer has said already. A positive image of the CCE is created in the mind of the customer. He will have a 
feeling that the CCE is actually listening to him. Active listening means actually listening to what a customer tells you. It 
means asking clarifying questions when the customer says something vague or that requires elaboration. For example, 
if a customer enters the store, comes to the Customer Care Executive and says “I need a post-paid plan which gives me 
an SMS plan and also network connectivity. The call rate should be minimal. I want minimal STD rates also’’. Then the 
CCE replies, “Ok Ma’am I got it, you a post-paid SMS plan with tariffs for local and STD at a minimal rate. This is a good 
example rephrasing of information.

5.1.3 Clarity in Communication
A Customer Care Executive should clearly communicate with peers/seniors about tasks at the store. Try to communicate 
in a way that conveys your meaning and demonstrates respect for your listeners. To communicate with clarity be sure 
to:

 � Know your point. Be crystal clear about what you want to achieve as a result of your communication.

 � Limit yourself to the main points. If you say any more than that you confuse your listener. 

 � Focus on the individual’s behaviour and avoid making slanderous remarks while speaking. 

5.1.4 The Art of Listening

but want the see a display of all useful products in front of them so that they can choose. If impulsive customers are 
treated suitably, there is a high probability that these customers could be responsible for a high percentage of sales. 

Need Based Customers- These customers are product specific and want to buy items for which they have a specific need. 
These are frequent visitors but do not buy every time. These customers should be shown ways and reasons to switch 
to other similar products and brands and initiating them to buy these. For such customers, identifying and confirming 
customer expectation is very important. It is easy to loose these customers in the absence of positive interaction.

Wandering Customers- These are not sure what to buy so that they are least profitable. They visits stores mostly to 
confirm their needs on products. They search for features of the most promising products but do not buy them. To 
make them buy patiently tell them the positive features of the products so that they develop a sense of interest.
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Summarizing conversations - Look at the given conversation:-

Customer: I want a broadband service for my phone.

CCE: What type of broadband plan you are looking for?

Customer: I want a plan which fulfils my need.

CCE: Ok Sir, do you want the plan for official or purpose personal?

Customer: For personal use.

CCE: Do you travel a lot?

Customer: Ya, once or twice a week.

CCE: Ok Sir, then let me make a description for you about your plan, you need a broadband plan for personal use, with 
roaming free facility.

The best plan for you is Plan 123. You can see its benefits in this pamphlet.

Tolerating silences

Tolerating silences means giving time to customers to feel comfortable in the store as soon as they enter the store. The 
Customer Care Executive should give time to customers to first see the products’ leaflets, brochures and pamphlets 
and examine it on their own. The executive should not disturb the customer. After sometime he can approach the 
customer.

5.1.5 The Art of Asking Questions/Probing
Salespeople should ask questions for several reasons. First, questions get the customer to participate in the sales 
process. By asking questions, executives encourage customers to actively engage in a conversation rather than passively 
listening to them. Participating in a conversation makes them more likely to hear and remember what is said. Second, 
questions show customers the salesperson is interested in them. Finally, salespeople can collect valuable information 
using questions.
Here are some guidelines for effective questioning:

 � Encourage longer responses. Don’t ask questions that can be answered with a simple “Yes” or “No”. For example, 
ask, “What do you know about this brand?” rather than “Have you heard of this brand?”

 � Space out questions. When an executive asks several questions one right after the other, customers may feel 
threatened. One method for spacing out questions is to encourage customers to elaborate on their responses.

 � Ask short, simple questions. Avoid questions with two or more parts. When faced with complex questions, 
customers might not know which part to answer, and the salesperson might not know which part of the question 
is being answered.

 � Avoiding leading questions. Leading questions just put words into the customer’s mouth and do not tell the 
salesperson what the customer is actually thinking. The question – ‘‘Why do you think this is a good service?” gets 
at a customer’s positive thoughts but does not reveal their reservations.
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5.1.6 Exhibit: Sample Questions
1. Would like to have a glass of water (To make customer comfortable)?

2. How may I assist you (To understand customer needs)?

3. Do you have a Pre or Post-paid connection (To understand customer’s preferred choice)?

4. Which company’s SIM are you using currently (To know customer’s choice or brand)?

5. What is your usage (To know customer’s usage rates and offering them best suited plan as per their usage)?

6. Did you travel a lot (If yes, show them a fast connection plan. If the customer travels out of the state then give 
information about national roaming incoming free)?

7. Do you use internet (If yes, show a plan having high internet usage e.g.: a plan having 2 GB 3G data and 5.76 mbps 
upload speed. It helps to send emails, instant messaging, play YouTube and much more)?

8. Do you call a specific number frequently (To give them a plan suitable to their need. For example in this case  t h e 
plan would be “Free calling to one local brand number”)?

9. How many text messages do you send in a day (To give them a plan suitable to their need. For example in this  
case the plan would be “3000 SMS local and national”)?

10. What kind of a phone do you have (To know customer’s choice or brand)?

11. Which scheme do you think best suits your usage or daily activity (To know customer’s opinion and act accordingly)?

12. What feedback have you got from your friends and relatives who recommended this scheme to you  
(The executive requires this information for understanding people’s feedback)?

13. What is the one thing that you like the most in this scheme (To find out which feature attracts customer the most)?

14. What are your expectations/requirements for this product/service (To know customer’s expectations)?

15. What are the best things about this scheme (To know customer’s needs)?

16. What other issues are important to you (To know customer’s choice)?

5.1.7 Interpreting and Using Nonverbal Communication
Nonverbal communication is non-spoken form of expression—body language (body angle, face, arms, and hands), 
space, and appearance—that communicate thoughts and emotions. A CCE needs to:

 � Interpret customers’ nonverbal signals and

 � Use nonverbal communication to improve their selling effectiveness.

It is hard to interpret nonverbal signals by observing only a single gesture or body position. Call Centre Executives, 
thus, need to consider the pattern of signals a customer generates to interpret the person’s feelings. To increase their 
effectiveness, salespeople can also use nonverbal signals as follows:

 � Use cooperation signals to indicate sincere interest in helping customers satisfy their needs. Avoid power signals. 
They intimidate customers and make them feel uncomfortable.

 � Nothing creates rapport like a smile. The smile should appear natural and comfortable not a smirk or clown like 
exaggerated grin. To get the smile right, practice in front of a mirror.
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5.1.8 Patterns of Non Verbal Communications
Interpretation Body Angle Face Arms Hands

Power, dominance, 
superiority

Exaggerated leaning 
over

Piercing eye contact Hands on hips Hands behind neck 
or back

Nervousness, 
submission, 
apprehension

Fidgeting or shifting 
from side to side

Head down. 
Minimum eye 
contact

Hands to face, hair. 
Rubbing back of 
neck

Wringing hands, 
Fingers clasped

Disagreement, anger, 
scepticism

Turning body away Negative shake 
of head, frown 
Lips pursing eyes 
squinting, chin 
thrusting out

Arms crossed, 
Finger under collar

Finger pointing, 
Hands gripping edge 
of display.

Boredom, disinterest

Slouching against 
display

Lack of eye contact, 
looking at the door, 
at the watch 

Touching the nose 
while speaking, 
Pulling an ear while 
speaking

Playing with an 
object on display 
case, drumming on 
display case

Suspicion, 
secretiveness, 
dishonesty

Moving body away, 
Sideways glance

Avoid eye contact, 
Squinting e yes, 
Smirking

Pinching bridge of 
nose, tugging at 
clothes, scratching 
head

Fingers crossed

Uncertainty, indecision Pacing back and forth Head down or 
tilted, biting lip, 
shifting eyes left 
and right

Hand gripping chin, 
putting glasses in 
mouth

Pulling neck

Evaluation Head tilted slightly, 
Ear turned toward 
speaker

Slight blinking of 
eyes, squinting. 
Eyebrows rose, 
nodding

Putting hands 
to chest, free 
movement of arms 
and hands

Putting index finger 
to lips

Cooperation, 
confidence, honesty

Back and forth 
movement of body

Good eye contact. 
Slight blinking smile

Hands on hips Open hands

 � Direct eye contact reflects sincerity; glancing from side to side or at a wall has the opposite effect. But staring can 
make a customer feel uncomfortable.

 � Hand movements can have a dramatic effect. Pointing a finger can be used to reinforce important points in the 
presentation. Too many hand gestures can distract attention from the verbal communication.

 � Good voice and speech habits are critical. To avoid monotony, salespeople should vary the rate and loudness of 
their speech. Simple messages may be delivered faster than more complex messages.
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1. Identify the given non-verbal expressions and write in the space provided.

_____________________            _____________________                  _____________________    

1. List four kinds of customers and the ways to handle them.

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Write any three guidelines for effective questioning.

__________________________________________________________________________________________

__________________________________________________________________________________________

3. Write any five patterns of non-verbal communication.

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Prepare a role play on the given techniques for effective listening:

a. Repeating or rephrasing information 

b. Summarizing conversations 

c. Tolerating silences 

Practical

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
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Selling is an act of promotion and influencing customers to buy a product or service, in return for money or other 
compensation.

Selling:

Selling is trying to make sales by persuading someone to buy one’s product or service. In the most basic terms selling 
can be said to be giving or exchanging goods for money. Today, however, with the growth of marketing, selling does not 
only mean mere give and take but also refers to the attending of consumers’ needs. It is the way you help customers 
to buy products and services of your business. 

5.2.1 Sales Process

At the end of this unit you will be able to:

1. Describe the techniques of selling, up-selling and cross-selling

2. List down objections and their types

UNIT 5.2: Sales Process
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This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Up-selling:

Effective sales promoter suggests additional items before the original sales transaction is completed. In a display, there 
are many other items (usually of lesser price than the main product) displayed along with the main or core product. 
Such items usually compliment the main product. Pushing for add-on sales is the responsibility of the sales promoter, 
as he/she is the one who interacts with the customer. For example, extended warranties, extra batteries, covers, other 
accessories etc.

Fig. 5.2.1 Sales process



92

Participant Handbook

When selling additional items, sales promoter should avoid becoming too aggressive. The sales promoter can mention 
available merchandise without offending the customer. When additional suggestions are appropriate, the Store 
Promoter should make them in a positive way. Asking “Anything else?” isn’t as effective as saying “You’ll need a cover 
for your new phone.”

Tips on Up-Selling and Cross-Selling

 � Once your customer has made a decision to buy, their wallet or pocketbook is open, and additional purchase 
decisions are much easier.

 � Mention the add-ons before the sale is completed, but after the major purchase decision has been made. Do not 
rush to make an add-on sale before the customer has actually made up his/her mind to buy the main product.

 � If you’re offering products or services your customer needs, recognise that you are actually helping them. Be sure 
to put forward the add-on offer in such a way that you make it clear that you are helping the customer rather than 
merely making money.

 � Offer relevant add-ons to your customers based on their shopping cart content or past purchase history. Use about 
techniques like “you might also like” and “other customers purchased”. These techniques will help you assure the 
customer that the add-on items are really helpful items.

 � Make sure whatever you offer your customer is adding value to their original purchase. If not, then the customer 
will simply feel that you are trying to cheat him/her.

Cross Selling:

Cross-selling is the action or practice of selling an additional product or service to an existing customer. The objectives 
of cross-selling can be either to increase the income derived from the client or clients or to protect the relationship 
with the clients. For example, if someone comes to the store to recharge his phone, you can sell a 3G internet pack 
along with it.

Fig. 5.2.2 Up-selling
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Importance of Selling, Upselling and Cross Selling in your job:

The success of business is dependent on the ability to meet the needs of your customers and sell your products and 
services in a way that is sustainable. Effective selling can make a significant improvement to the profitability of your 
business in both the short and long term.

It is impossible for a business to stay in the market unless they make substantial amount of sales. No matter how good 

your products/services are, till the time it does not meet the requirement of customers, it will not have considerable 
amount of sales. Hence, it is essential for a business to put in necessary amount of effort in selling their products and 
service.

As a Call Centre Executive, you can promote sales by:

 � Educating customers about products, services and new offers. For e.g. showing brochures of new plans and product 
offerings.

 � Planning and executing customer engagement initiatives to facilitate brand recall and customer satisfaction. For 
example, customer satisfaction surveys conducted by an organisation.

 � Identifying problems narrated by the customer and providing appropriate resolution.

 � Identifying opportunity to sell/up-sell and cross-sell.

 � Read about new products and services with reference to the organisation.

 � Keep abreast with latest knowledge

Let us understand the selling process in detail. The steps involve:

 � Approaching the customer

 � Probing to identify needs

 � Presenting and demonstrating products and services

 � Handling Objections/Reservations

 � Making the sale

 � Building future sales

Fig. 5.2.3 Cross selling
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STEP 1: Approaching the Customers

In the first stage of the selling process, the Customer Care Executive approaches customers with unsatisfied needs and 
tries to stimulate problem recognition. Approaching a customer is a method of getting the customer’s attention and 
building interest in the merchandise quickly.

STEP 2: Probing to Identify Needs
In the second stage, customers search for information to satisfy 
their needs, and the CCE collects information about customers 
so they can determine what merchandise might be appropriate. 
Through questioning or probing, the CCE must find out what the 
customer is looking for. What product the customer has currently 
and what are his needs that might be used to get information 
about the required product. For example - “Do you want a call 
plan that has less roaming charges?”

Purpose of Approach: The purpose of the CCE’s approach is to 
narrow the customer’s focus from a broad generalized interest to a 
consideration of specific items.
Elements in Approach: The approach consists of greeting the 
customer with a genuine smile, introducing yourself by name, 
developing rapport, and getting the customer to consider specific 
merchandise. Many customers are anxious, particularly, when 
considering a change. Customers also may feel threatened, thinking 
a CCE is going to be too aggressive. The customer’s anxiety can be 
reduced by a smile or an introduction and welcome note.
The initial rapport building continues until the customer’s verbal or nonverbal communications indicate he is ready to 
talk about the merchandise. Then the CCE starts to direct the customer’s attention by asking a question, mentioning a 
feature or benefit of the merchandise, discussing the good’s manufacturer, or pointing out a special value. Given below 
are examples of these techniques:
“I am Ranjan, may I help you to choose an SMS pack you are looking for”
“In this section different internet connections that suit the needs of different people are available. I will explain you 
the ones that suit you”
“This plan has many benefits. This plan has free calling on one local number, 1500 SMSs as well as 2 GB of 3G data free.”
“Try this plan, it has many feature like, you may download Hello tunes, ringtones and wallpapers of your choice. This 
pamphlet gives you all the details.”
“Do you like to call or message?
After the initial contact has been made, the next step in the retail sales process is to collect some information from the 
customer. 

Fig. 5.2.4 Approaching the customer

Fig. 5.2.5 Probing to identify needs
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Also collect information about the customer’s preferences for pre or post-paid plans and internet usage. Understand 
the exact need or expectation of the customer. You have to understand their buying pattern and offer customized 
solution. That means you have to do selling based on customer analysis. Customers often want to know the CCE’s 
opinion. Even when customers come in knowing what kind of plan they want, they might want to know the CCE’s 
opinion about the features and benefits of various plans.

Consider the conversation below:
Customer: I am looking for a new connection for my phone.
Executive: Ma’am which connection are you using currently?
Customer: Right now I am using the SIM of ABC company.
Executive: Which features do you not like about the connection from your experience?
Customer: Oh! I had a huge network problem issue with this connection and also the plans were not matching my 
needs.
Executive: Ok ma’am. Where do you operate your phone the most?
Customer: I travel by road frequently to rural areas as I work in an NGO.
Executive: Ma’am I understand the network issue now, please tell me what is your usage like, do you surf the net, and 
prefer calling or messaging?
Customer: I need to use email very often and yes I do a lot of messaging.
(Here the executive probes or in simple terms questions the customer in order to identify her needs)
To satisfy the customers’ needs, the CCE must ask questions and then listen carefully to customer’s replies and 
comments. Effective listening is the most important step in building rapport with customers. In the third stage, The 
CCE presents and demonstrates the features and benefits of the product to assist the customer evaluate alternatives.

STEP 3: Presenting and Demonstrating Products and Services

In the third stage, CCE presents and demonstrates the features and benefits of the product or the services to assist the 
customer to evaluate alternatives. A suitable product has to be introduced to the buyer. For this the executive should 
have thorough knowledge of the complete range of products/services he is selling and that of the competitors also. He 
should be aware of the strengths and limitations of company’s products and services.

Benefits
Customers buy benefits, not features. A benefit is a specific need that 
is satisfied when a customer buys a product. In every buying situation 
customers ask themselves, “What am I going to get out of buying this 
merchandise?” A CCE answers this question by explicitly indicating 
which need of the customer will be satisfied by the product.
For example:

 � Our company has the highest connectivity in the entire country. 
You will have seamless connectivity in the North Eastern states of India.

 � “Yes, we have a range of broadband plans that exactly suit your requirement. The price will vary and the features 
are……. ”. “As you need a connection to watch films primarily, you can take and HD connection because it has good 
quality and….”

Fig. 5.2.6 Presenting the product
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STEP 4: Handling Objections/Reservations

Objections can arise at each stage in the sales process. For example, a customer may not be willing to talk with a 
Customer Care Executive during approach. Reservations can also arise when the CCE is presenting the product.

Types of Objections/Reservations

Some common reservations arise because the customer does not want to buy at the time or is not satisfied with 
the price, the product, the store and its service, or the Customer Care Executive. Customers often resist making an 
immediate decision. A list of these reservations can be seen below:

Types of Reservations

 � Timing: I haven’t made up my mind

 � Merchandise: I don’t think this is made well.

 � Sales person: I don’t like him.

 � Price: This is too expensive

 � Decision: I will have to talk it over with my wife or I think I’ll wait awhile.

These reservations indicate the customer is not convinced of the need for the merchandise or its benefits. The real 
reason for postponing the purchase may be the price or the merchandise itself. Also, some customers just do not like 
to make decisions. Reassurance works better than pressure with indecisive customers.

Uncovering Objections

The reservations customers’ state are often just excuses for not buying. Usually the customer gives a reason that 
appears to be the real reservation. Some customers agree to everything or make no comments. Then they decide not 
to buy the merchandise. In such a situation the CCE must uncover the reason.

Methods for Handling Reservations

The best approach for handling reservations is to relax and listen. Allow customers to verbalize their feelings completely. 
Ask questions to clarify their reservations, but don’t interrupt to provide an answer even though the answer might 
seem obvious.

A Customer Care Executive needs to respond to reservations in a way that will not start an argument. One way is to turn 
the customer’s statement into a question. A CCE should aim to soften the reservation by getting on the customer’s side. 
This can be done by agreeing with and then countering the objection. Customers usually expect the CCE to disagree 
with an objection. Instead, the CCE should recognize that the objection is offered sincerely and respect the customer’s 
view.

After agreeing, the CCE should proceed to provide information the customer might not be aware of. Skill is necessary 
in stating the counter. For example, the CCE might respond to the reservation,

“I don’t like this plan as sometimes my balance is deducted” by saying, “You know, Sir, I felt the same way when I first 
used this plan, but it has so many useful features and benefits like low internet pack, free minutes and free SMS that 
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I can’t afford to switch to any other plan.” With such a counter, the CCE agrees that the customer’s reaction is not 
unusual but then proceeds to turn the objection into a benefit.

STEP 5: Closing the Sale
Closing a sale occurs when the seller and buyer agree to the 
conditions of the sale and the buyer makes a firm commitment 
to the transaction. You have to create a win-win situation with 
the customers by convincing them to buy products/services as 
well as fulfilling their needs. Closing the sale should not be seen 
as a transactional event, but rather as the natural ending of the 
sales process. There can be different ways of finally closing the 
sales. They are explained with the help of examples.

STEP 6: Building Relationships and Future Sales

This is extremely important especially for selling services as telecom products and services sales which consist of lots 
of upgrades. The relationship between a customer and a Customer Care Executive should not end when a sale is made. 
It is becoming increasingly important for CCE to build long-term relationships with customers so they will return to the 
centre and seek out the Centre Executive the next time they’re buying.
Methods for building goodwill include:

 � Keeping the customer’s interest paramount

 � Reaffirming the customer’s judgment

 � Ensuring proper use of the merchandise

 � Handling customer complaints

 � Remembering the customer between visits and

 � Providing “above and beyond” service
Basically the CCE has to sell, up-sell and cross-sell products and services in a Relationship Centre. To know about 
different types of plans refer to Annexure -2.
Given below is a conversation which shows a typical sales process and the various stages involved in it.

Executive: Hello Ma’am! How may I help you?
Customer: I am looking for a new connection for my phone.
(Approach the customer after some time when she enters the centre)

5.2.2 Building Relationship for Future Sale- an Example

Direct Close: “Shall I finalize this Sir?” or “Shall I make the bill please?”

Test Close: “Do you have all the information to make a decision for buying the SIM?”

The Suggestion Close: “I suggest that you go for M Post-paid plan as it matches your current requirement.”

Assume Close: “When would you like to the connection to be installed?”

Alternative Close: “Which will it be Sir the ‘My Plan abc’ or the ‘My Plan xyz’?”

Fig. 5.2.7 Demonstrate the product
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1. List five types of selling techniques.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What is the difference between up-selling and cross-selling? Give examples and explain?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Executive: Ma’am which connection are you using currently?
Customer: Right now I am using the SIM of ABC company.
Executive: Which features of the connection do you not like? What has your experience been?
Customer: Oh! had a huge network problem issue with this connection and also the plans were not matching my needs.
Executive: Ok Ma’am. What is your usage like? Do you surf the net? Do you prefer calling or messaging?
Customer: I am very fond of surfing the net and yes, I do a lot of messaging.
(Here the executive probes or in simple terms questions the customer in order to identify her needs)
Executive: Ok ma’am I have the best plan for you. This will provide you 2 GB of 2G internet connection for Rs. 89 and 
also 2000 (Local + STD) SMS just for Rs. 50.
Customer: No, actually I prefer a 3G connection.
Executive: No problem Ma’am, we have another plan for you. You can go for the “My Plan xyz”, which gives you a 
combo pack of 2GB of 3G data for Rs. 99 and 2000 (Local + STD) SMS for just Rs. 50.
(The executive should know how to handle objection and should suggest a solution to it)
Executive: Ok Ma’am, shall I finalize this plan for you?
(The executive should not waste any more time in case the customer changes her mind. The executive will ask for her 
permission to close the sale)
Customer: Ya sure, thank you very much.
Executive: Thank you ma’am for visiting the store. Hope to see you in future.
(A simple effort can help in building relationship for future sale)
Customer: Thank you bye.
Executive: Bye.

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

3. Write the steps involved in the selling process.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

4. What are reservations?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

5.  Write any three types of reservations.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Data is the primary asset of any organisation and its security is essential. This data could be:
 � Client information such as their phone, financial or personal details
 � The way your organisation functions, like its process flow, the way departments work, names and contact 

information of those people.  
 � Policies and procedures of your organisation.

5.3.3 Information Security

5.3.2 Data

It is important that as an call centre executive, you take all measures for information security. Information security is 
the practice of defending information from unauthorised access, use, disclosure, disruption, modification, inspection, 
recording or destruction. This data could be electronic data, physical data, etc.

Before beginning this session we will look at one story which will give you a clear picture about data confidentiality. 
This story is of Aman, who is a CCE at a Relationship Centre. He used to work in the organisation and always planned 
to make more money. Once an outsider came to the Relationship Centre for some query. After seeing that no one 
was in the store except Aman, as it was lunch time, the man started talking about his real intention. After seeing that 
Aman was also taking interest he told him that he wanted personal details of the customers like contact number, 
address etc. for his own business. He promised Aman that he would pay per hundred customers. Aman was excited and 
agreed to the deal, as he had access to all the customers’ information. Gradually, he started sharing the information 
with the man. After some time, a colleague of Aman, Sudhanshu caught him red-handed, as he had listened to their 
conversation on phone. He immediately informed senior authorities. Every one praised Sudhanshu for his work. Aman 
was fired from the job. He also realised that the man had fooled him and not paid him any money for his “kind” work. 

1. If you were in Sidhansu’s place what would you have done?

__________________________________________________________________________________________

__________________________________________________________________________________________

At the end of this unit you will be able to:

1. Explain the importance of data confidentiality

2. Practice data confidentiality measures

5.3.1 Case Study

UNIT 5.3: Data Confidentiality 

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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5.3.4 Client Confidentiality
The client places a lot of trust in the organisation and in the In-Store Promoter before sharing his information. It’s 
crucial for the In-Store Promoter to maintain that trust and faith by maintaining the confidentiality of the client’s 
information. It’s a criminal offence to share this data. If you are found guilty, you can be convicted and imprisoned.

The measures that organisations take to maintain data security are:
 � The data received from the client during the time of processing in any form such as hard copies or soft copies is 

destroyed or returned back after the completion of the work.
 � None of the employees are allowed to bring any storage devices like memory cards, CD/ DVD/ Blue Rays Disc, 

external hard disk, floppy disk, pen drive, etc.
 � At the entry and exit points, the security guards frisk the employees to check that none of the storage devices are 

carried in or out by any of the employees.
 � CDs, DVDs, pen drives, disk drives or any other storage devices are not allowed in the individual PCs and in the 

office premises without prior permission from authorised management team members.
 � The professional firewall system restricts the users to surf or access unauthorised sites on the internet.
 � The firewall restricts the rights of all the users within the company.
 � A written Non-Disclosure Agreement (NDA) is obtained at the time of joining from each employee.
 � Entrance in operations area is restricted by finger print software, as per the privacy norms and requirements.
 � The server for the website is protected too and it’s crucial for the In-Store Promoter to ensure that he doesn’t use 

or access or try to dig for unauthorised information.
 � Limited access to the network is given through login IDs and password protection.
 � Passwords and access controls are well defined for authorised internal persons.

1. Why do you think these measures are taken by any organisation?

__________________________________________________________________________________________

__________________________________________________________________________________________

Visit a Relationship Centre and figure out the data confidentiality measures to be implemented in that particular 
centre

 � Do not reveal customer’s financial and personal information to anybody other than the account holder that to after 
verification.

 � Classified information, written or verbal should not be given to any person/ customer/ competitor/ without 
permission.

 � Be careful not to share information about one customer with another.

Exercise
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6. Service Desk and 
    Customer 
    Management

Unit 6.1 – Service Desk

Unit 6.2 – Customer Management

Unit 6.3 – Addressing Quick Responding Time (QRC)

Unit 6.4 – Customer Feedback

Unit 6.5 – Interpersonal Skills

Unit 6.6 – Dealing with Unhappy Customers

Unit 6.7 – Rapport Building

TEL/N0107
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At the end of this module, you will be able to:

1. Explain the concept of service desk and service management

2. Explain the concept and phases of customer service management

3. Identify and address customer quick responding time (QRC)

4. List down the importance of customer feedback

5. List down the importance of interpersonal skills

6. Describe the steps involved in dealing with angry customers

7. Explain the need of building rapport with customers

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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At the end of this unit you will be able to:

1. Explain service provided by CCE to customers

2. List the different types of customers

6.1.1 Service Desk
Let us understand what Service Desk is and how it operates.

A service desk is a Relationship Centre that provides a single point of contact (SPOC) between a company and its 
customers, employees and business partners. The purpose of a service desk is to ensure that users receive appropriate 
help in a timely manner.

Service desks are designed to handle Queries, Complaints and Service Requests. The purpose of a help desk is to 
ensure excellent Customer Service to ensure customer retention and loyalty. 

Some of the services provided by these centres are given below:

 � Provide easy facility to take a new connection

 � Subscribe to any value added services and get more information about them

 � Facilitate payment of bills 

 � Provide account related information after verifying customer details

 � Assess the customer documents for completion & correction and process them

 � Give an estimate of possible resolution time to the customer, if an immediate solution is found 

In a Relationship Centre, basically the CCE has to concentrate on three types of customers. They are: 

1. Existing customers

2. New customers

3. Potential Customers

To provide the best service a CCE must try:  

 � To organize all the walk-in customers, through a manual or a token system.

 � To prioritize customers on the basis of their category and attend to them accordingly, while doing so always 
reassuring all the customers that he will attend to them at the earliest and requesting them to wait for their turn.

 � Provide an estimate of resolution time to the customer, if an immediate solution cannot be found. 

UNIT 6.1: Service Desk 

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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1. Name some of the services provided by a Relationship Centre.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Name the three types of customers.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Prepare a chart on the operation of service desk

Exercise
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At the end of this unit you will be able to:

1. Explain the concept and phases of customer service management

2. Practice customer service management

6.2.1 Customer Management 
Customer management means to deliver positive customer experiences which lead to customer loyalty and new 
business generation through referrals. A service desk can enhance the customer’s experience and satisfaction, expand 
their lifetime value and improve business.

6.2.2 Customer Service 
Service is the commitment to providing a high quality of service to customers with a positive attitude, knowledge, 
technical support, in a timely manner. 

Phases of Customer Service Management:

1. Pre-Customer service 

 � Putting products in order (in proper shelf, stacked together with similar products, cleaned regularly etc.) 

UNIT 6.2: Customer Management

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.
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Fig. 6.2.1 Customer management 
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6.2.3 Verification
Verification of the Customer

To most of us, there may be some instances where we called customer service, it could have been just an inquiry or a 
complaint. However, have you observed that in almost all of your calls, the representative asks for your identification? 
Why is call verification so important?

The answer is to keep customer’s data and service safe. For example, if the CCE does not follow the verification process 
and activates some service the customer will come to know of the new service when he receives the bill.

Verification Scenarios

The CCE is supposed to verify under the following scenarios:

 � Balance depletion

 � PUK information

 � Activation and deactivation requests

 � B number ( the number being called) information

 � While raising request/complaints (except DND (Do Not Disturb) and network)

 � Getting product knowledge (company, price, user instruction, etc.) 

 � Information about competitors (which other company is selling similar products, their price, comparative features, 
advantage of your own product etc.) 

2. Customer Service 

 � Attend to customers (Greet, introduce products, understand needs, give information asked for like guarantee, 
features, advantages, discounts, etc.).

 � Give product choices and information (offer different products available, give information like guarantee, 
comparative features, advantages, discounts, etc.).

 � Offer the best solutions to the customer (help to make the best choice keeping all interests in mind to ensure that 
a sale can be closed as well as ensure that the need of the customer is fulfilled).

 � Handle customer queries, requests or complaints (such as renewal of subscription, queries on new plans, complaints 
about network troubles or overbilling, troubleshoot and resolve customer’s product/service related issues).

 � Clear doubts or queries, if any about price, quality, features, and handle objections).

3. Post-Customer Service 

 � Analyse what more service can be offered (check the current service offered and plan how the customer service 
can be made better

 � Seek customer’s feedback in feedback register/diary/booklet 

 � Bring about the modifications in practice (execute the plan of making the customer service better)
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6.2.4 Escalation Process
Before escalating call of the customer a CCE should make an attempt to identify and resolve QRC in following ways 

 � Empathize with the customer

 � Listen attentively to the customer’s QRC and not interrupt 

 � Review the account and complaint details

 � Ask probing questions to ensure a clear understanding of the issue.

Take appropriate steps to correct the issue

If the customer still insists on speaking with a manager:

 � Escalate the call to the supervisor instead of arguing with the customer.

 � Provide the supervisor with information regarding the customer and the issue.

 � If no one is available immediately to handle the customer’s call, offer the customer the option of receiving a call-
back from a member of management within stipulated time.

 � Inform the customer that you are transferring his call to the supervisor. 

Verification Parameters

A CCE can ask following questions (only two) to verify the customer before activating and deactivating any service

 � Name of the customer (As per CRM)

 � Address of the customer (As per CRM)

 � Proof submitted by the customer

 � Frequently dialled numbers

 � Last 3 calls or SMS numbers

 � Date of birth of the customer
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1. Why is customer service crucial for a CCE?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. What are the three phases of customer service?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Exercise
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6.3.1 Addressing QRC
As we have seen another key task for a CCE at an RC is to respond to questions and inquiries, about products or services 
and, handle and resolve complaints. As a CCE, you need to:

 � Categorise the nature of customer’s interaction as a query, request or a complaint(QRC) and record it

 � Obtain and address adequate information from the customer to login QRC
In this chapter we will learn about different types of customer’s interaction at a Relationship Centre and how to handle 
them.
There are mainly three types of customer’s interaction at a Relationship Centre:

 � Query

 � Request

 � Complaint

6.3.2 Customer Query
A query is a question or inquiry. When the customer makes a query he/she is trying to get information about a product 
or service from the CCE.
General Queries at Relationship Centre

 � Balance /Billing enquiries 

 � Account Related 

 � New products or services 

 � VAS related

 � Tariffs and recharge related
SIM/PIN/PUK related information
The PIN is the Personal Identification Number that is configured for your SIM card and has to be enabled on the 
handset. This is any 4-digit number that you can set up on your SIM card. Each time when customer switches on his 
handset, there will be a request to enter the PIN. If the PIN is entered wrongly 3 times, the customer will get a request 
for a PUK code, which is the Personal Unlock Key. 
The PUK can be obtained from Customer Care. If the PUK is entered wrongly 10 times, the SIM gets block and will have 

At the end of this unit you will be able to:

1. Explain how to handle, resolve and follow up customer queries

UNIT 6.3: Addressing Quick Responding Time (QRC)

Unit Objectives
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National Occupational (NOS) is covered across Unit/s.
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symbols used in this book are described below.
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6.3.3 Customer Request
Through a request, a customer makes a request for a product or a service.

Types of requests 

 � Request Open

 � Request Self-Closed

to be replaced at a nominal charge.
The balance and validity along with other services will remain as it was earlier after SIM replacement
Customer can retain your old contacts if backup of the contacts has been created. However, in case of lost SIM cards, 
contacts cannot be retained.

Request Open 

In this, the executive will have to take action together with providing information.

For E.g. Activation/Deactivation of a Service which can be only processed through backend.

Example of Request-Open

A customer walks in to a relationship centre and requests the CCE to change his tariff plan; he informs the customer 
it will be changed from the next billing cycle onward and tags it as request in open option. He has done so because he 
does not have the rights to change tariff plan from his own end.

Request Self Closed

In this, the executive will take an online action together with providing information.

Example:

1. Instant Deactivation of a Service through vendor link.

2. Instant Activation of a Service through vendor link.

Example of Request-Self Closed

A customer calls the relationship centre and requests the CCE to deactivate the caller tune of his number. The executive 
deactivates it from his system and informs the customer. Here the CCE has rights to deactivate caller tune so he tags 
the request as “self-closed”. 

6.3.4 Customer Complaint
In a complaint customer complains against services due to facing some issues. 

Types of Complains:

 � Complaint Open

 � Complaint Self-Closed
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Complaint-Open 

A CCE registers complaint as Open in the following scenarios:

1. Gap in Service 

2. Gap in Product

3. Gap in Process

4. Validated Disputes 

5. Benefits not received 

Open Complaints can be resolved by the back-end team only.

Complaint-Self-Closed

A CCE should self-close a complaint in the following scenarios: 

1. Online Waiver 

The CCE can give waiver to the customers within some limits. For example, a customer refuses to pay penalty for delay 
in payment as he got bill on the due date. The CCE can give a waiver to the customer and close the complaint.

2. Planned Downtime 

In case the CCE is aware of planned downtime in the region, as the network team is restoring a site and if a customer 
is calling from the same region he can inform the customer and close the complaint.

3. Known issue of benefits not received

For example, in a recharge promo a customer is supposed to get Rs. 50 extra on recharge of Rs. 500. However, the 
customer complains that he has not received any benefits on recharge of Rs. 500. As per backend communication all 
customers who recharged under recharge promos have not got benefits, and all the benefits will be credited in one 
week. In this case a CCE can close the complaint and inform the customer about TAT.

4. Known Disruption in Service

For example, there is a communication that customers who will use 3G services may face problem during late hours 
due to some technical problem and it will be rectified in a week. If a customer complaints regarding the problem in 3G 
services during late hours the CCE can inform the customer and close the complaint.

6.3.5 Handling Customer Complaints 
Here are a few tips to handle customers’ complaints:

 � Listen to the customer

 � Paraphrase the issue

 � Apologize for the inconvenience

 � Acknowledge the customer

 � Explain the action taken to resolve customer concern

 � Thank the customer
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6.3.6 Exhibit: Customer Service
Anybody associated with the service desk should be committed to providing good, if not outstanding, customer service:

Sl. No. Practice Explanation
1 Always listen to the 

customer and their 
issues

It is important that you do not just hear the words but that you understand the 
tone of voice (and where appropriate body language), and most importantly 
that you do not rate the severity of the issue against the help desk manual 
you have in your desk drawer. The customers’ problem may not be of high 
importance as per rules but it is important enough to the customer for them to 
have taken time out of their precious working day to seek help.

2 Respond to 
customer needs

Nobody wants to hear the word “no” or “we can't help.” Even when you cannot 
meet all customer needs or fix all their issues there will always be something 
that you can do.

3 Learn how to 
apologise

You need to know how to say sorry for mistakes regardless of whether you 
caused them or not. Your customers are probably not concerned with who 
caused the issue; they just want somebody to take responsibility for it, to 
acknowledge that a mistake was made, and to help them fix it.  

4 Value your customer 
complaints

You may not like them but ultimately they help you understand your product/
service better and give better service.

5 Get regular 
feedback

Encourage and welcome suggestions on how you can improve your services, 
this will help your organisation improve their products and you to improve your 
service.

 � Even if customer is abusing you or is angry at you, remember the customer is facing some issue because of which 
he is behaving like this. So do not take it personally.

 � Remain calm throughout the interaction.

 � Focus on the problem not the person.

 � Turn an unhappy person into a happy customer.

1. What are the steps involved in handling customer complaints?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
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_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

2. What are the different types of customer’s interaction in a Relationship Centre?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

3. What are the general queries at a Relationship Centre?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

4. What are the types of requests?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

5. What are the types of complaints?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

6. How to handle customer’s complaints?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

7. State true/false.

a)   All requests can be self-closed by CCE. 

b)   CCE should tag as complaint if a customer wants to activate his MMS services.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

8. When an irate customer visits a Relationship Centre for complaint what does a CCE do?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________
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At the end of this unit you will be able to:

1. Explain the importance of Customer’s Feedback

2. Discuss the advantages of Customer’s Feedback

6.4.1 Customer Feedback
Organised information collected from your customer about their opinion, suggestions and experience about the 
product or service is called Feedback.

6.4.2 Importance of Customer Feedback
Customer feedback allows telecom companies to better understand how customers rate and use their products or 
service as against competitive products. It is of high importance for determining where a company’s products and 
services excel or fall short against customer’s expectation and against alternate service providers in the market. For 
example, customers may like the network coverage of ABC Telecom as against XYZ Telecom, which means that XYZ 
Telecom would need to improve on their network coverage.

Customer feedback can help telecom companies evaluate how employees treat customers. Customer Service 
Satisfaction surveys are a common type of marketing research. Companies can determine through surveys whether 
customers are getting their questions answered and problems resolved. Additionally, a company can determine if some 
customer service representatives are being rude to customers, especially if the topic of rudeness comes up frequently 
during the surveys.

6.4.3 Advantages of Customer Feedback
Get Honest Opinions

Customer feedback is vital to telecom industry to get honest opinions on services or products from customers. These 
opinions can make it easier to get into the minds of the most important critics.

Improve Relations

When your customers feel that your company truly cares about them and what they think, they may be more likely to 
be loyal customers. When a business makes changes according to feedback, it shows that they truly listen and respect 
those opinions.

UNIT 6.4: Customer Feedback
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6.4.4 Feedback Recording Process
Here is the way telecom companies capture customer feedback.

For Telecom Companies it is the front line staff that speaks to customer’s day 
in and day out. Hence it is really important that companies put a feedback 
recording process and train its frontline staff on how to deal with angry 
customers and record feedback.

Let us look at the feedback recording process first.

Take Customer Details

The first thing you do before you proceed in logging customer feedback is to 
ensure that you have all the required customer information like the customer’s 
telephone number, mailing address and name. This is required to ensure that 
you access and record the feedback for the right customer.

Check for similar feedback in history

Check if the customer has complained or provided feedback for the same 
situation, because sometimes it could be that the instrument that the customer 
is using is faulty and there is no problem in the service provided. This procedure 
can also result in immediate resolution and improving customer satisfaction.

Create a feedback/complaint reference number

Every time you log a feedback or a complaint on the customer’s account the 
system generates a reference number which the customer can use to follow up 

Inexpensive Business Advice

Some companies pay a huge amount for someone to come in and tell them what improvements need to be made to 
products and services to get more customers. Customer feedback is essentially inexpensive business advice directly 
from the source.

More Customers

When a business is willing to receive feedback and listen to it, word spreads and more customers may be willing take 
a connection based on your commitment to excellent customer service.

Positive Changes

A company does not like to brag about the negative aspects of their operation. 

Capturing in Timely Manner

In today’s competitive Indian telecom market it is very important to capture customer feedback in a timely manner. 
This will allow your company to improve their product or service and also enhance customer satisfaction.

Fig. 6.4.1 Steps involved in feedback 
recording process

6. Ensure to submit/save

5. Provide customer with 
          reference number

3. Create a feedback 
          reference number

2. Check for similar 
          feedback in history

1. Take customer details

4. Type the feedback in 
          customer words
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Type the feedback in customer words

Type the feedback in customer words as much as possible. It is human nature that a person can best explain a problem 
when he has been facing the problem. When your customer faces a problem and is giving feedback about the same 
they are able to emphasize on it with specific words which help the resolution team to understand customer’s dis-
satisfaction level. This will also allow the specialist to understand the exact problem.

Provide customer with reference number

Provide your customer with the feedback / complaint reference number as they will call back if the problem is not 
resolved within their expected time. Providing customer with the reference number will allow the other customer care 
executives to locate the feedback form and provide the customer with an update without wasting time and further 
adding to dis-satisfaction.

Ensure to submit/save

This is a very small action in the process but can become the biggest problem when not done. Submit/save the feedback/
complaint immediately after you are done talking with the customer. Not following this step or human error can result 
in either no resolution or a call back to the customer wasting time.

Let’s look at a simple process in dealing with customers who have a feedback or complaint.

 � Greet

 � Listen

 � Acknowledge

 � Apologise or Thank

 � Reconfirm

 � Reassure

Greet: It is important to greet the customer as this will act as a conversation starter and make the customer feel 
welcome and that he has a real person on the other side of the call.

Listen:  When your customer is giving feedback they want to be heard and would not want you to be interrupting them.

Acknowledge: When your customer is talking they also need to know that they are being heard and are talking to a 
person. Use verbal nods like “Ah-ha” “ok” “alright” etc. This will let the customer know that you are interested in what 
they have to say and also understand what they are talking about.

Apologise or Thank: Say that you are sorry for what has happened and that you will ensure that the issue is resolved 
as soon as possible if the customer is calling for a negative feedback or a complaint. Say Thank You when the customer 
is calling you for a positive feedback or giving a compliment.

Reconfirm: Customers would like to know if you have really understood what their issue is and this can be done by 
telling the customer what you have understood. This is called reconfirming as this will allow you to clear any doubts or 
information you need to ensure that the issue has been resolved.

and check for resolution status. This also helps telecom companies to categorise complaints and ensure that based on 
the nature of complaint a specialist can speed up the resolution process.
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Reassure: Always use statements like “Don’t Worry”, “Be rest assured”, “I will help you”, as this will make the customer 
feel that you have understood their problem and know how to resolve it.

1. State True / false

a. Customers are the most important critics.

b. Customer feedback does not make a lot of difference to the work I do as a customer care executive.

c. Capturing feedback in a timely manner is very important to enhance customer satisfaction.

2. Fill in the blank

The first step in recording a feedback is ................................................... (documenting/listening).

Scenario:
A customer had requested your organisation to change his 3G plan and convert it to a 2G plan some 3 days ago. The 
customer’s request was not met and he is not happy with the service. You have to take his feedback, document it and 
process it for rectification.
_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________
_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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At the end of this unit you will be able to:

1. Explain the importance of Interpersonal Skills

2. Discuss the importance of communicating effectively

6.5.1 Case 1
Sarita used to work for the vice president of human resources, Sweta. Sarita was a human resources assistant. 
Sweta was very pleased with Sarita's job knowledge, hard work, and initiative. Sweta used to tell Sarita 
that her work was so good that, "You remind me of myself." One day, in an effort to compliment Sarita, 
Sweta says "I think I'll call you Mini-Me," and then does just that by calling Sarita Mini-Me around the 
office from then on. Sarita is understandably upset. She wants to be treated like an individual, not as an 
extension of her boss. Unfortunately, Sweta remains completely unaware of her subordinate's anger or 
why calling Sarita Mini-Me is inappropriate. Subsequently, Sarita leaves and Sweta loses a great employee.  

1. Do you think Sarita’s anger was justified or will you brand her as an egoistic person?
----------------------------------------------------------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------------------------------------------------------

6.5.2 Case 2
Vivek had just joined a telecom store as the store promoter. He was very interested in the store's layout and had ideas 
on how to improve it. In his first compnay meeting, he was most excited it and tried to tell his ideas to everyone but 
the words did not come out right, thereby not creating any impact. Rather everyone was confused.
He asked for a second chance. This time he prepared well in advance. He wrote his complete speech, made it visual 
with diagrams to enable everyone to follo, & he practiced his talk. At the 2nd attempt everything was much better. 

1. If you were in Vivek’s place would you have given it a second try or would have just thought yourself to be inefficient 
to communicate your ideas?
__________________________________________________________________________________________
__________________________________________________________________________________________

6.5.3 Case 3
Rina worked in an insurance contact centre. She had a colleague Geeta whom she did not like too much. Rina often 
exchanged mails her friends during work.  

In many of those mails she told her friends unpleasnt things about Geeta. Accidently she send one of those mails in 
which she was speaking badly about Geeta to several people in the company. 
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6.5.4 Interpersonal Skills
These competencies are what we call Interpersonal skills. Interpersonal skills are those life skills which we use every 
day to communicate and interact with other people. People with strong interpersonal skills are usually happier in both 
their personal lives and professional.

In a Customer Centric culture such as at a Relationship Centre interpersonal skills are the key to positive customer 
experiences. As a CCE RC you are required to attend to walk-in customers, convince them to buy company’s products/
services, handle and resolve their issues. 

In order to do so you must:

 � Have a pleasing personality and enjoy communicating with people 

 � Be sensitive to other’s feelings and resolve conflicts calmly.

 � Use the customer’s language to create comfort 

 � Make sure the customer feels he is the winner in case of disputes 

Being aware of yourself and how you interact with others - you can improve your interpersonal skills. 

6.5.5 Developing Interpersonal Skills
Learn to Listen

Listening is an important part of connecting to other people. It is not the same as hearing. When we do active listening, 
we must listen not only to the words but the tone of voice and the non verbal messages sent with them. An active 
listener should use the techniques of clarification and reconfirmation to understand what the other person has said. 
Try not to think of what you are going to say next when you are listening, instead focus on the message being received. 

Be Aware of Others’ Emotions

Being empathetic or aware of other emotions helps us connect with other people. When talking to people we must 
make and maintain eye contact and use first names where appropriate. We must not feel afraid to ask others for their 
opinions. When saying something consider the emotional impact of what you are saying. 

Empathise

Empathy is trying to see things from the point of view of others. When communicating trying not to be judgmental 
or biased.  Instead try to see things from the other person's perspective. Stay balanced with your emotions and try to 
understand the emotions of others. When required offer your personal view point honestly and clearly. Always bear in 
mind that certain subjects might be taboo or too stressful for others to discuss. Another quality of interpersonal skills 
is encouraging the other person.  Awful words of encouragement, praise others make them feel welcome wanted in 

It created a factor in the office. Rina's attack on Geeta was respected to her supervisor. Rina was very embarrassed at 
her behaviour and lack of integrity. She was asked to leave. In addition it put a black mark on the entire team working 
with Rina.

1. Do you think what Rina did was correct in Rina’s friend’s place would you have continued chatting with Rina or 
reported her disloyal behaviour to supervisor?

__________________________________________________________________________________________

__________________________________________________________________________________________
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value in your communications. Effective communication is a key interpersonal skills and has many benefits. People with 
good communication skills or effective communication skills have better interpersonal relationships.  

Encourage

Offer words and actions of encouragement, as well as praise, to others. Make other people feel welcome, wanted, 
valued and appreciated in your communications. Effective communication is a key interpersonal skill and learning how 
we can improve our communication has many benefits. Effective communication skills are fundamental to success in 
many aspects of life. People with improved communication skills usually have better interpersonal relationships.

Communication is a two way process so improving communication involves both how you send and receive messages.

6.5.6 Effective Communication
 � Focus on what you want to communicate. Before starting a conversation, aways plan and pay close attention to 

what do you want to sey, How you are going to say it and what are the exact words you want to use. 

 � Communicate Clearly: The aim of communication is to make sure that the receiver understands what you were 
trying to say. Therefore, when you are sending your message be considered how it might be received by the other 
person. If you opt in clear what you are saying, you would avoid misunderstandings and potential conflicts with 
others.

 � Nonverbal communication: This is a very important aspect of any communication. Be aware of the messages that 
you could be sending nonverbaly that is through your body language - your eyes, your arms, your way of standing, 
smiling etc.

 � Pay Attention:  For effective communication, you must pay particular attention to the differences in attitudes 
cultured, abilities of the other person before conveying your message.

 � Simplify: Effective communication is communication which is easily understood. Avoid jargon or over complicated 
language. Explain things as simply as possible.

 � Use humour: Laughing relieves stress and anxiety for all. Most people are drawn to people who make them laugh. 
Waiver make sure your humor is appropriate to the situation. Your sense of humor can help you break ice, lower 
barriers and gain the affection of others. 

 � Treat People Equally: Avoid patronizing people and treat people as your equal. This way you will build trust and 
respect.

 � Attempt to Resolve Conflict: Do not let conflicts pending. Troubleshoot and resolve them as they arise. Try not to 
be biased but be open to conflict resolution. 

 � Maintain a Positive Attitude and Smile: Always be positive upbeat and friendly with other people. When things do 
not go as per your plan stay optimistic, if you smile and stay cheerful people are more likely to be drawn to you.  

 � Only Complaint When Absolutely Necessary: Nobody likes to be around complaining people. If you are very angry 
or upset about something wait for sometime before taking action. If you do complain do so calmly. Try to find some 
positive aspects of the situation and avoid making unnecessary criticism.
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1. Why are interpersonal skills crucial for your job role?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. List a few techniques to build interpersonal Skills.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Prepare a story with these components in it. i.e. 

1. Why should there be a team? 

2. How does a Team work best? 

3. Interpersonal skills

______________________________________________________________________________________________

______________________________________________________________________________________________

______________________________________________________________________________________________

______________________________________________________________________________________________

______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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At the end of this unit you will be able to:

1. Describe the steps involved in dealing with angry customers

2. Practice the process of dealing with angry customers

6.6.1 Case - 1
Roshan is a customer care executive at a relationship centre. One day just as the office opened one of 
his most important client walked in and unannounced. Looking very angry. Roshan stood at to greet him, 
however the client exploded in an angry to tirade because Roshan’s store has failed to activate his phone 
service on time. This delay meant that the client was unable to demonstrate a pre product, thus he lost an 
important sale. Roshan tried his best to calm the client but nothing help for situation. The client got angrier-
angrier, shouted accusations and left the store.  He never to do business with Roshan’s organisation again.

1. How would you behave if you were in Roshan’s place?

__________________________________________________________________________________________

__________________________________________________________________________________________

6.6.2 Managing Angry Customers
Let us explore how to deal with angry or difficult customers and see how a CCE can smooth things over, so that the 
customer feels satisfied.

STEP 1: Adjust Your Mind Set

As soon as you realise that your client is unhappy put yourself into a customer service mind set. This means that don't 
think that the situation is not your fault, or that your client has made a mistake, or that he or she is giving you unfair 
criticism.

All that matters now is that you understand that your client is upset, and that it’s up to you to solve the problem. Focus  
on 100 percent on your client, and on solving his problem.

STEP 2: Listen Actively

Listening attentively and actually to what the client is saying – his grievances is the most important part of his process.

Start the dialogue with a neutral statement, such as, “Let’s go over what happened,” or “Please tell me why you’re 
upset.” This subtly creates a partnership between you and your client, and lets him know that you’re ready to listen.

Try not to jump to conclusion or to solve the situation right away. Try to create a partnership with your client by 
speaking with neutral statements like "Let go over what happened". Let your client tell you his history.  As you listen 
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actively becuase this is what he wants, to be listened to first.

STEP 3: Repeat their Concerns

When the client has explained his anger replace his words, repeat his concerns so that you both are sure that you are 
addressing the right concerns. Ask questions to make sure that you have identified the problem correctly.

Repeating the problem shows the customer you were listening, which can help lower his anger and stress levels. More 
than this, it helps you agree on the problem that needs to be solved.

Use calm, objective wording. For example, “As I understand it, you are, quite rightly, upset because we were not able 
to enable the data services that we promised you last week.”

STEP 4: Be Empathic and Apologize

Once you understand your client’s concerns, be empathic and understanding.

Make sure that your body language also communicates this understanding.

For example, you could say, “I understand why you’re upset. I would be too. I’m very sorry that we didn’t get the service 
to you on time, especially since it’s caused these problems.”

STEP 5: Present a Solution

Now that you have listened and empathised you need to present him/her with a solution. There are two ways to do 
this.

If you feel that you know what will make your client happy, tell her how you would like to correct the situation.

You could say, “I know you need these services activated by tomorrow to put your website online. I will call our technical 
team and we will come to your office with you right now and resolve any problems latest by today evening.”

If you are not sure you know what your client wants from you, or if they resist your proposed solution, then give her 
the power to resolve things. Ask her to identify what will make her happy.

For instance, you could say, “If my solution doesn’t work for you, I’d love to hear what will make you happy. If it’s in my 
power I’ll get it done, and if it’s not possible, we can work on another solution together.”

STEP 6: Take Action and Follow-up

Once you’ve both agreed on a solution, take action immediately. Tell the client every step you are going to take to fix 
the problem.

Follow up with the client over the next few days to make sure that she is happy with the resolution. If you can, do more. 
For example, you could send a gift certificate, giving a discount on the next purchase.

STEP 7: Use the Feedback

Your final step is to reduce the risk of the situation happening again.

Identify how the problem started. 

Find the root cause of the problem and make sure it is fixed immediately.

Above all stay calm.
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Sometimes a client or customer may become verbally abusive towards you or your team. Know in advance what you 
will tolerate, and what you will not. If things escalate, you may need to be assertive and stand up for yourself, or even 
walk away from the situation to give the client time to cool down.

1. What are the steps involved while dealing with angry customers?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Why is it always important to deal with angry customers?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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At the end of this unit you will be able to:

1. Explain the need of building rapport with customers

2. Describe the technique involved in building rapport

6.7.1 Why Build Rapport
Rapport is the ability to create a strong common bond with another by making him feel that you understand him.

In every industry, it is important to connect with customers. 

A CCE RC can use rapport to:

 � Break the ice with new colleagues or with your boss when you start a new job.

 � Create a positive connection with new or existing team members.

 � Build good relationships with clients or suppliers.

 � Get support for your ideas and proposals.

How to Build Rapport

Let us look at strategies that you can use to build rapport with others.

Find Common Ground

Imagine you go to a America to study and there you meet another fellow Indian. Who is not only from India but also 
from your state the state of Bihar. How delighted this makes you feel. This creates an instant connection between you 
and him. This is the instant rapport between two people. Finding any common ground helps establish rapport so when 
you meet someone new try to find something that you may have in common. You can use open ended questions to 
discover something about the other person which may be in common to you may be attending the same school, having 
the same tastes in music,  knowing the same people etc. It can even help if you share similar beliefs and values.  Another 
technique of building rapport is empathizing or understanding other people by seeing things from their perspective 
and recognizing their emotions. As soon as you start doing this you start talking on their wave length and hence it is 
easy to connect. When trying to build rapport always remember the basics of good and effective communication such 
as having a firm handshake, always maintaining eye contact during the conversation, smiling openly, maintaining good 
posture and being sincere. Facing the other person when talking in place of looking at your mobile and your computer. 

Be Empathic

Empathy is about understanding other people by seeing things from their perspective, and recognizing their emotions. 
Once you achieve this, it is easier to get “on their level.”
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Remember the Basics

In developing rapport with others, you should also use the tried-and-true basics of good communication:

 � Shaking hands firmly (in cultures where this is acceptable).

 � Looking people in the eye.

 � Smiling.

 � Holding your head up and maintaining good posture.

 � Asking open-ended questions.

 � Being sincere.

 � Facing the other person instead of looking at your computer screen or mobile device.

These basic tenets form the foundation of great communication, and it is hard to establish good rapport without them.

6.7.2 Tips to Build Rapport with Customers
Remember Their Names

Try to remember the names of your regular customers. It makes themselves valued, appreciated and created a bond.

Know More about Them

An effective way to establish rapport with your customers is by getting to know them and their likes and dislikes. Let us 
take the case of Starbucks. Starbucks has huge customer loyalty. Why is that is it because some servers are good,  No, 
they train their servers to remember people's names and also remember what people like and do not like. Meera is a 
frequent Starbucks customers. She loves sandwiches but does not like sweets. I server in Starbucks will never offer her 
a cinnamon bun. If you know your customers then you can shape your sales strategy to suit their tastes. Similarly if a 
customer say Mr. Satish Kumar is a regular at your store to get a monthly recharge on his phone, should you be trying 
to convert him to a postpaid or offering the best prepaid you have. Make them feel special. The best way to establish 
rapport with your customers is to give them special treatment that means it is to give them something more than what 
other customers get. This could be in the form of discounts, free memberships or sometimes even a special giveaway. 
One great example of trying all the three together could be, "Good morning Satish Ji"  welcome back so nice to see you 
again. As a loyal and valuable customer, I would like to offer you a new value pack of rupees five hundred recharge with 
a full talk time valid for twelve months at a rate of rupees four hundred. If you are courteous & professional and you 
make your customers feel special, you encourage them to come back to your store again and again.

Make Them Feel Special

Nothing helps you establish rapport with your customers better and faster than special treatment. This is not just about 
remembering their names anymore. It is about giving them something other customers do not get.

This would be in the form of discounts, free memberships or even a special giveaway! One great example of tying all 
three together would be something like, “Good morning, Satishji! It’s so nice to see you again! As a loyal and valuable  
customer I would like to offer you a new value pack of Rs. 500 recharge with a full talk time valid for 12 months at a 
rate of Rs. 400. 

By making them feel special, you encourage them to come back to your store again and again.
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6.7.3 Exhibit: Helpful Rapport Building Behaviours
 � A positive body language to help you and the other person feel more relaxed.

 � Make eye contact approximately 60% of the time but be careful not to make them feel uncomfortable.

 � When listening, nod and make encouraging sounds and gestures.

 � Smile! openly and warmly

 � Use feedback to summarise, reflect and clarify back to the other person what you think they have said. This gives 
opportunity for any misunderstandings to be rectified quickly.

 � Be empatie. Demonstrate that you can understand how the other person feels and can see things from their point 
of view. 

 � Be non-judgemental towards the other person. Let go of stereotypes and any preconceived ideas you may have 
about the person.

 � If you have to disagree with the other person, give the reason first then say you disagree.

 � Be honest and admit if you have made a mistake.

 � Offer a compliment, avoid criticism.

1. Why is rapport building crucial for a CCE in a Relationship Centre?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. List few techniques of building rapport with the customers.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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It is quite easy to learn how to establish rapport with customers. Do not be intimidated by the thought of talking to 
people. Just think of it as talking to a friend. Always remain pleasant, open and interested.

Remember to always display courtesy and professionalism.
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7. Monitor and 
     Analyse Self 
     Performance

Unit 7.1 – Monitoring and Analysing Self-Performance

TEL/N0108



132

Participant Handbook

At the end of this module, you will be able to:

1. Explain the ways to monitor and analyse performance

2. Practice monitoring and analysing performance

Key Learning Outcomes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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At the end of this unit you will be able to:

1. Explain the concept of tracking, monitoring and measuring self-performance trends

2. Describe the process related to churn, collection and bad debt recovery

Measuring performance of a CCE can include external factors such as impact on customer goals and satisfaction, and 
internal factors like goals, critical success factors for the CCE and process. These measurements are essential ingredient 
for feedback, which drives accountability and improvement. Everyone expects to become the best at what they do. 
So how do you really know who is the best? It is through performance reviews against peers and targets set by the 
company. Let us look at the different performance parameters and review stages relevant to a telecom contact centre.

7.1.2 Performance Parameters

7.1.1 Introduction

Let us look at some common performance parameters in a telecom Relationship Centre:

1. Targets for Revenue Performance

The purpose of these targets is to ensure the CCE is adding to the revenue generation of the company. A CCE focuses 
on selling, up-selling and cross-selling as per targets given to him by superior to increase Average Revenue per User 
(ARPU).

2. Processes related to collection and bad debt recovery:

Collection is the process of chasing past due receivables on customer account. This is a very significant part of the 
responsibilities of a CCE and directly impacts the bottom line of the company. This means sending notifications to the 
customer and taking appropriate action in case of overdue payments.

A collection process is two pronged:

 � Collections Aging Tracking: This is the process of tracking and tagging the customer invoices that have not been 
paid within the due date. It deals with the “age of account receivables”; for example, invoices that are 0-30 days 
overdue, 30-60 days overdue, etc.

 � Collections Actions: Collection action is the action that is performed when the account receivable reaches a 
particular age. For example, reminder messages to the customer. Some examples are:

 � Send reminder mail and/or call: This is the first action to collect the due. The CCE contacts the customer 

UNIT 7.1: Monitor and Analysing Self-Performance
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through mail/ message/ phone to remind for payment if there is still no payment then proceed to the next 
action.

 � Red letter: For example, a “Pay in seven days” letter is issued. Still if the payment is not received, then proceed 
to the next action.

 � Disconnect the service: The network management department suspends the service.

 � If you still have not been paid, then consider using a debt collecting agency to collect the outstanding money 
from your customer.

3. Processes related to Churn Management:

Following the old marketing axiom that it is usually more profitable to retain a current customer than to acquire a new 
one, many companies deploy specialized customer care representatives to handle churn incidents. Churning refers to 
blithely switching of customers from one provider to another and often back again or over to a third one. 

The key to winning and retaining customers is intimate, up-to-date knowledge of customer segments. Call Centre 
representatives react to each customer’s needs in a single conversation to ensure a positive customer experience. 
When the customer feels valued and “seen’’ they want to stay with the same company.

As a performance parameter the CCE works to directly reduce customer churn, while pursuing the most targeted 
customer base to increase revenue.

4. Processes related to Complaint Reduction: 

These are related to customer surveys and external/internal audits.

5. Adherence to Service Level Agreements:

SLA – ASLA is a commitment that the operator gives to its customer. It specifies, usually in measurable terms, what 
services the contact centre will furnish. There is always a written service level agreement so that services for the 
customers can be measured and justified. For example: any walk in customer should not wait for more than 10 minutes 
or if a number needs to be transferred to another person’s name it will be done in maximum 48 hours.

6. Adherence to First Time Resolution: 

The best way to increase customer satisfaction and in turn increase the profits is to resolve the customer query 
or complaint the first time. A resolution offered in the first time is called a First Time Resolution (FTR). It is a key 
performance metric for the CCE as FTR impacts customer satisfaction. For Example: If the CCE gets 100 queries in a day  
80 out of these must be resolved the first time.

7.1.3 Customer Service Quality Parameters
Apart from the above direct performance criteria the CCE performance will also be judged based on soft skills i.e. the 
way the CCE interacts with the customers.

Soft skill parameters are simple to understand. Let’s look at general telecom quality parameters:

 � Personal Hygiene and grooming of the CCE

 � Greeting – Have you used the appropriate greeting?

 � Listen – Have you listened to the customer carefully or made them repeat?
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 � Solution – Have you offered relevant and accurate information/solution?

 � Offered new services – Have you offered new services to customer based on needs?

 � Offer Assistance – Have you checked if the customer required further assistance?

 � Close – Have you closed the call on a positive note?

 � Gathering Feedback - Have you obtained and documented feedback from the customer?

 � System Update – Have you updated customer information appropriately?

7.1.4 Review with Superiors
Performance parameters provide an indication of the CCE’s performance by measuring key processes. By monitoring 
the right parameters, the CCE can gain valuable insight into his performance and make the adjustments needed to 
optimize performance. Following points will help in review with superior:

 � Know which parameters are most important to monitor to get the results you want.

 � Know the definition, calculation, and example of each parameter.

 � Prepare for the discussion with superior.

 � Solicit feedback from superior.

7.1.5 Review Period
Now let’s look at review periods in a Telecom Relationship Centre.

Daily

Daily reviews are done generally during the morning briefing to ensure everyone knows what to focus on and is set for 
the day.

Monthly

Monthly reviews are done to ensure that every one is aware how they are performing and know who really is doing 
good and who needs guidance and help with regards to their performance.

Quarterly

This is done every three months to know a cumulative performance and to know how your performance will look like 
at the half yearly review.

Half Yearly

Done every 6 months to judge agents for reward and recognition and also to let you know how your annual performance 
will look like if you continue the same performance trend.

Annual

This is the review that will be considered for salary raise if the performance is good or for corrective measures if you 
are below the company standards.
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1. List five performance parameters of a CCE in Relationship Centre.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

2. Name the five types of review periods used in any Relationship Centre.

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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8. Data Expertise

Unit 8.1 – Resolving Data Related QRC

TEL/N0109
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At the end of this module, you will be able to:

1. Explain the process involved in resolving data related queries, requests and complaints

Key Learning Outcomes

About this book
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symbols used in this book are described below.
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At the end of this unit you will be able to:

1. Explain the process involved in resolving data related queries, requests and complaints

Most telecom operators also provide data services in the form of wireless internet, broadband or fixed line connections 
and data card. 

With lightning fast speeds, customers can now surf seamlessly at the place and time of their choice. Be it checking 
mails during transit or updating status while with friends or watching movies on the go, they experience the internet 
without any limits.

The different types of data plans available are:

1. Modem Enabled

2. Broadband: Fixed line or Wi Fi

3. 2G

4. 3G

5. 4G

The main differentiator in all of these is the speed of connection. How it impacts final usage is the time that it takes to 
download. For E.g., you have a 2G connection and take a plan of 250MB. With this connection it will take 10 minutes to 
download a 10MB file, whereas if you have a 3G connection with 250 MB the file will download in 2 minutes.

In this module we will learn how a CCE will resolve data related queries, complaints and requests. The role of the CCE 
here is to:

 � Identify issues by asking relevant questions and resolve customer’s data related concern 

 � Provide resolution to customers on data related QRC’s to reduce repeat walk-in/interactions of customers with 
data related queries 

 � Understand customer needs and pitch best suited data related plans and products to the customers 

Let us do a quick recap of what are QRC’s before we begin.

Query: A Query is a question or an inquiry. Through a query, a customer tries taking information about their account 
or any other services.

Complaint: In a complaint customer complaints against services as he is facing some issues. 

Request: Through a request, a customer makes a request for a product or a service.

Here are examples of some common queries, requests and complaints and how the CCE resolves them.

UNIT 8.1: Resolving Data Related QRC

8.1.1 Data Plans

Unit Objectives
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Queries
What is Mobile TV?
What is 3G?
What can I do with 3G?
Which is your cheapest and best plan?
How much can I download in a 2Mbps plan?
What is the validity of this plan?
In this plan of Rs. 999 after downloading 100 GB what will be the speed of my connection?
What is the range of this Wi-Fi?
Requests
Change my plan from 2G to 3G
Installation of broadband services 
Auto update my plan each month
Installation of Anti-Virus
Complaints
Slow Speed
Frequent disconnection of internet
Incorrect user ID/Password
Remote computer not responding
False Billing
Some sites not opening
ADSL Unstable
Wi-Fi access problem

8.1.2 Exhibit: Sample QRC

When responding to QRC the CCE must always try to create a positive customer experience by displaying courtesy and 
professionalism.

8.1.3 Resolving Queries
As a CCE you must help the customer in an efficient, respectful and friendly manner. In order to resolve queries:

 � Familiarize yourself with the company's products and services. For example, you must read the company brochures 
to understand the various data plans, their benefits and prices. Also ask your supervisor what the most frequently 
asked questions from customers are and how you should answer them. Refer to annexure-3 for sample plans.

 � Suggest services or products that could help the customer. For example, a customer shows interest in a low cost 
internet plan for his mobile, while probing you realize that he travels a lot and needs a connection with fast speed 
and high download, so you suggest a 3G plan to the customer as it will serve him better when he is travelling.
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8.1.4 Fulfilling Requests
The CCE must listen and make sure to get all the information. Details can make a difference. After you look into the 
request, be sure to give a turn-around time to fulfil the request and have a follow up communication, and follow 
through on any commitments you make.

For example, a client requests for a broadband connection. A CCE must take all the relevant details from the customer 
namely – customer name, address and phone number and tell the procedure to the client i.e. a feasibility study, 
verifying of documents and installation. The CCE must also inform the client the time that the whole process will take, 
say a week before the connection is installed. 

8.1.5 Resolving Complaints
When a customer complains, attend to them immediately. Do not avoid as it worsen the situation. Approach the 
customer as soon as you learn they are unhappy, and;

 � Listen Intently: Listen to the customer, and do not interrupt them. They need to tell their story and feel that they 
have been heard. For example, a customer may complain that the speed of his 3G connection is slower than the 
promised speed and how this is impacting his connection with his friends and his social life, his work, and his ability 
to enjoy streaming media.

 � Thank Them: Thank the customer for bringing the problem to your attention. You can resolve only those things  
which you are aware of.

 � Apologize: Sincerely apologize to the customer on behalf of your organisation for the way the situation has made 
them feel. Apologizing sincerely helps to soothe down the customer's anger. Don't give excuses or judgements.

 � Seek the Best Solution: Try to determine what the customer wants as a solution. Ask them, often they want less 
than you initially thought - especially when they perceive your apology and intention is genuinely sincere. For 
example, you can ask the customer to reset the browser and delete the cookies to enable faster speed, or check if 
the validity is expiring. Both of these options could be causes for slow speed.

 � Reach an Agreement: Agree on the solution that will resolve the situation to their satisfaction. For example - The 
CCE can offer to also check the company network and get back to the customer.

 � Take Quick Action: Act on the solution quickly. Customers will often respond more positively to your focus on 
helping them immediately versus than on the solution itself.

 � Follow-up: Follow-up to ensure the customer is completely satisfied.

1. What are the steps involved while approaching the customers in resolving complaints?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

Exercise
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9. Program Wrap-Up

Unit 9.1 – Interview Skills

Unit 9.2 – FAQs
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At the end of this module, you will be able to:

1. Understand what is an interview

2. Develop the skills to participate in an interview effectively

3. Know commonly asked questions in an interview

4. Revise and integrate learning’s of the training program

Key Learning Outcomes
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At the end of this unit you will be able to:

1. Describe interview skills

9.1.1 Interview
An interview is a conversation between two or more people (the 
interviewer(s) and the interviewee) where questions are asked 
by the interviewer to obtain information from the interviewee.

Common Types of Interview:

1. Traditional HR Interview:

Most interviews are face-to-face. The most traditional is a 
one-on-one conversation with the HR Executive where the 
candidate’s focus should be on the person asking question. 
You are advised to maintain good eye contact, listen 
carefully and answer promptly.

2. Panel Interview:

In this situation, there is more than one interviewer. A panel ranging from two to ten members may conduct this 
part of the selection process. This is an ideal chance for you to display group management and group presentation 
skills.

3. Technical interview:

The objective of this interview is to basically evaluate technical knowledge. A majority of the questions will be 
based on the skills sets mentioned in the candidate’s resume.

4. Telephone Interview:

Telephone interviews may also be used as a preliminary interview for candidates who live far away from the job 
site.

Before going for an interview, it is important to have clarity of the role you are applying for. It’s also important that you 
know where you are applying and who will you be talking to. Your answers should tell the employer that you are the 

UNIT 9.1: Interview Skills
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match they are looking for. 

This requires you to do a small research in the following areas:

 � Company

 � Job Description 

 � Yourself (Skills, Values & Interests) 

 � Resume (Experience)

If you were an employer, you would have chosen a person who is sure of himself, is calm and confident. So it is 
important that you are:

 � Confident

 � Relaxed

 � Sure of yourself

 � Prepared

 � Dressed professionally       

It is important that you dress professionally. It is a proven fact that the way we dress makes a huge difference in the way 
we are perceived. Our body language and the first impression we make communicates 90% of what we want to say to 
other people. It is very important to make a great first impression. For a good first impression it is important that we:

 � Smell good

 � Have a professional appearance

 � Pay attention to our grooming 

 � Make eye contact 

 � Ensure that our overall personality contributes t our complete perception. 

How to Dress for the Interview
Men Women

Long-sleeved buttoned shirt (clean and pressed)

Dark shoes (cleaned and polished) and dark socks

Get a haircut (short hair is always best)

No Jewellery (chains, earrings, piercing)

No beards or Tattoos

Conservative pumps, no stilettos 

Jeweller one set of earrings (preferably knobs)

No bangles

Minimal use of makeup
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9.1.2 Dos and Don’ts in an Interview
Some of you might have faced an interview and some of you might not have. However, by now, you definitely have a 
better understanding what are the accepted standards of a professional behaviour

Read the sentences given and mark them as dos or don’ts, in relation to an interview:

During the Interview
 � Be confident, not arrogant

 � Sell yourself - Keep your energy up

 � Maintain your posture

 � Be positive, do not complain

 � Know your resume and accomplishments.

Sentence Dos Don’ts 
Be yourself
Burp while talking!!!
Just out from a ‘powder factory’ (wear too much make-
up)
Reach just about the right time for the interview
Just barge in to the cabin/ office
Forget to greet the receptionist/ do not respond
Think before you speak
Do your homework - visit the company website
Take time to think (TTTT)
Wear bright coloured clothes on the D-day
Emphasis on your strengths
Argue/ Debate with the interviewer
Chew gum during the interview.
Review your educational and work experiences
See your documents flying out of the file (Being clumsy)
Thank the interviewer
Have the ‘they need me’ attitude
Maintain eye contact and good body language
Only give monosyllabic answers(depends on the kind of 
questions asked…in-between)
Carry a copy of your resume



148

Participant Handbook

1. What are the different types of interviews?

__________________________________________________________________________________________

__________________________________________________________________________________________

__________________________________________________________________________________________

It is not sufficient to have ideas. They have to be expressed effectively during the interview. The parameters that the 
candidates are assessed on during the interview are very simple to understand. These simple yet important parameters 
are: 

 � Active listening

 � Clarity of thought and expression 

 � Appropriate language  

 � Appropriateness of body language

 � Fluency

 � Good delivery: The ideas expressed fluently in the right voice, right tone, and right articulation.

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________
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At the end of this unit you will be able to:

1. Explain the commonly asked questions in an interview

9.2.1 Frequently Asked Questions
Now that the basic professional etiquette of interviews are covered, let us look at the kind of questions you might be 
asked. 

1. Tell us something about yourself. Or run us through your resume. 

 � This is usually the first question you would face in any interview. 

 � The basic purpose of this question is to start the communication and put the candidate to ease.

To answer this question, start with some information about your family background, educational qualifications and 
work experience. Focus on the things you have learnt during the training. Confidence is the most important factor to 
keep in mind while answering this question. Talk with confidence and speak clearly without hesitation.
Try to speak for not more than 2 minutes.

Sample Answer 1:

My name is XYZ. I live in New Delhi. I have completed Higher Secondary Part 2 form ABC School. My father runs a shop 
and my mother is a house-wife. I have a work experience of 1 year with DEF Company Ltd. I love to play football/cricket 
and watch movies.

Sample Answer 2:

My name is LMN and I live in Srinagar. I have passed 12th standard form PQR School. There are 4 members in my family, 
my father, mother and my elder sister. My father is a businessman and my mother a school teacher. My sister works as 
a language trainer. I am a big fan of football and I was the captain of the school football team.

2. How would you describe yourself as a person? Or how are you as a person?

The main purpose of this question is to see if you have some of those qualities which employers look for in their 
employees like – dedicated, performance oriented, hardworking, etc. So, pick one of your qualities which employers 
are looking for and offer it as an answer. The answer to this question should ideally be in one line.

UNIT 9.2: FAQs

Unit Objectives

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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Sample Answer 1:

I am an ambitious person with passion to learn.  

Sample Answer 2:

I am a hard working person and I like to work in a team.

3. Where do you see yourself 3 years from now? Or where do you see yourself 3 years down the line?

The purpose of this question is to see if you are ambitious and also to check your stability with the company.

Sample Answer 1:

In three years from now, I see myself as a more responsible position where my company treats me as an asset and hope 
to grow with this company.

Sample Answer 2:

“Three years from now, I see myself working with this company at a position where I am responsible for handling a 
team.”

4. What is your greatest strength? Or what are your strengths?

 � To answer this question – analyse the requirements of the position you have applied for and make a list of the 
qualities a person working in that profile should have. 

 � Pick up the qualities you have and give them as an answer. For example, some of the qualities people applying 
for jobs in retail and BPO industry are: patience, fluency in English, good listening skills, positive attitude, team 
player etc.

 � This is quite an expected question so you must go prepared with an answer for this question well in advance.
Sample Answer:

One of my biggest strengths is my communication skills. I work very well with all kinds of people, and understand that 
everyone has different perspectives about projects and work tasks - so when I work with others I realize that everyone 
has different priorities and objectives. I keep this in mind when I communicate tasks that need to be accomplished with 
positive reinforcement and awareness of what others are working on.

Some of the strengths you may possess: 

 � Hard worker 

 � Punctual 

 � Determined 

 � Able to prioritize 

 � The ability to cope with failures and learn from my mistakes

 � Commitment to my work 
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 � Love to learn new things

 � Being a team player and working well with others

5. What are your weaknesses?

 � You must understand that it is perfectly normal for any human being to have some weaknesses. What is more 
important is to identify them and work on them.

 � So, if you are asked this question in the interview – stay calm and admit that you have weaknesses. There are 
two ways for you to answer this question now.

 � a) Offer a totally un-related weakness. For example, I am a very emotional person. I, at times, even get 
emotional while watching movies.
b) I think I can work a little more on my technical skills as I believe it will help me with my career.

Sample Answer: 

I have to work on having more patience and giving myself a break, because I always want everything done at once.

6. How do you rate your communication skills?

Communication skills play an important role in almost all the jobs you perform. Some job requires you to communicate 
internally with your team members, boss or management while others need you to communicate with customers.

Sample Answer:

My communication skills are fairly decent. I am constantly taking advantage of opportunities to develop my 
communication skills by listening, reading and writing.

7. Can you speak for two minutes on one of these topics?

You will be given some general topics to see your communication skills, on the spot thinking capability etc. So, read a 
lot and be ready to speak on some general topics.

Topics may include: 

 � Current Issues

 � Hobbies

 � Most memorable day of your life

 � Favourite movie

 � How did you spend your last weekend?

 � My Training Experiences 
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8. How do you rate your listening skills?

One of the key factors in communication skills and being a good team player lies in your listening skills. If you do not 
have them, develop them. Offer above average or good as an answer.

Sample Answer:

I am a good listener. I carefully listen to others without interrupting and speak only when it is required.

9. Do you consider yourself as a team player? Or are you a Team Player?

Working for any company these days means being a team player. So, the obvious answer to this is “Yes”. You may quote 
some examples where you worked as a team.

Sample Answer:

I enjoy working with others. I also like working in groups because it gives me a chance to share ideas and understand 
different perspectives and viewpoints.

10. How long would you expect to work for us if given an opportunity?

This question aims to find out your stability and see if you would jump at the first opportunity offered to you. To answer 
this question, you can just say that, “I intend to stay as long as I’m learning and growing & both of us are happy with 
the work.”

Sample Answer:

Given an opportunity, I see this company as a long term career prospect and with time build my career here.

11. Why should we hire you?

To answer this question, you need to prepare well in advance. 

Read through the requirements of the job properly and match the qualities, skills and experience you have with the 
requirement. Now offer this as a reason for you to be hired.

Sample Answer:

I am a keen learner and I believe I have necessary skills required to be successful at my job. I am also a team-player so 
that will help me to adapt to different situations and work better.

12. Do you think you can work under pressure?

Work and pressure are always going to co-exist. It might be the pressure at work or on personal front but you should be 
able to deal with it. So, the answer to this question should be “Yes” backed up with some example where you worked 
under pressure.
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Sample Answer:

Yes, I can work under pressure. I understand that every job comes with responsibilities and pressure will always be 
there. I have skills and patience to cope with work pressure.

13. Are you comfortable with learning new technologies?

Modern businesses run on technologies. So, you should be happy to learn them. Say “Yes”.

Sample Answer:

I am comfortable with learning new technologies as it will help me to perform my job in a better way. It will also help 
me to enhance my capabilities.

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

Notes

About this book
This Participant Handbook is designed to enable training for the specific Qualification Pack(QP). Each 
National Occupational (NOS) is covered across Unit/s.

Key Learning Objectives for the specific NOS mark the beginning of the Unit/s for that NOS. The 
symbols used in this book are described below.
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